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Chapter 1 
Introduction 

The design/check of steel frames is seamlessly integrated within the program. 
Automated design at the object level is available for any one of a number of 
user-selected design codes, as long as the structures have first been modeled 
and analyzed by the program. Model and analysis data, such as material prop-
erties and member forces, are recovered directly from the model database, and 
no additional user input is required if the design defaults are acceptable. 

The design is based on a set of user-specified loading combinations. However, 
the program provides default load combinations for each supported design 
code. If the default load combinations are acceptable, no definition of addition-
al load combinations is required. 

Steel frame design/check consists of calculating the flexural, axial, and shear 
forces or stresses at several locations along the length of a member, and then 
comparing those calculated values with acceptable limits. That comparison 
produces a demand/capacity ratio, which typically should not exceed a value of 
one if code requirements are to be satisfied. The program follows the same re-
view procedures when it is checking a user-specified shape or when checking a 
shape selected by the program from a predefined list.   

The program also checks the requirements for the beam-column capacity ratio, 
checks the capacity of the panel zone, and calculates the doubler plate and con-
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tinuity plate thickness, if needed. The program does not do the connection de-
sign. However, it calculates the design basis forces for connection design. 

Program output can be presented graphically on the model, in tables for both 
input and output data, or in calculation sheets prepared for each member. For 
each presentation method, the output is in a format that allows the engineer to 
quickly study the stress conditions that exist in the structure, and in the event 
the member is not adequate, aid the engineer in taking appropriate remedial 
measures, including altering the design member without re-running the entire 
analysis. 

The program supports a wide range of steel frame design codes, including 
many national building codes. This manual is dedicated to the use of the menu 
option "CSA S16-09." This option covers the “CSA S16-09 — Design of steel 
structures” (CSA 2009). The implementation covers loading and load combina-
tions from "NBCC 2010 Minimum Design Loads for Buildings and Other 
Structures" (NBCC 2010). 

The design codes supported under “CSA S16-09” are written in Newton-
millimeter units. All the associated equations and requirements have been im-
plemented in the program in Newton-millimeter units. The program has been 
enabled with unit conversion capability. This allows the users to enjoy the flex-
ibility of choosing any set of consistent units during creating and editing mod-
els, exporting and importing the model components, and reviewing the design 
results. 

1.1 Organization 
This manual is designed to help you quickly become productive using the CSA 
S16-09 steel frame design option. Chapter 2 addresses prerequisites related to 
modeling and analysis for a successful design in accordance with CSA S16-09. 
Chapter 3 provides detailed descriptions of the specific requirements as imple-
mented in CSA S16-09. Chapter 4 provides detailed descriptions of the specific 
requirements for seismic loading as required by the specification CSA S16-09.  

1 - 2 Organization 
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1.2 Recommended Reading/Practice 
It is strongly recommended that you read this manual and review any applica-
ble "Watch & Learn" SeriesTM tutorials, which are found on our web site, 
http://www.csiamerica.com, before attempting to design a steel frame. Addi-
tional information can be found in the on-line Help facility available from 
within the program. 
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Chapter 2 
Modeling, Analysis and Design Prerequisites 

This chapter provides an overview of the basic assumptions, design precondi-
tions, and some of the design parameters that affect the design of steel frames. 

For referring to pertinent sections of the corresponding code, a unique prefix is 
assigned for each code.  

• Reference to the CSA S16-09 code is identified with the prefix "CSA." 

• Reference to the NBCC 2010 code is identified with the prefix "NBCC." 

2.1 Check and Design Capability 
The program has the ability to check adequacy of a section (shape) in accord-
ance with the requirements of the selected design code. Also the program can 
automatically choose (i.e., design) the optimal (i.e., least weight) sections from 
a predefined list that satisfies the design requirements. 

To check adequacy of a section, the program checks the demand/capacity 
("D/C") ratios at a predefined number of stations for each design load combina-
tion. It calculates the envelope of the D/C ratios. It also checks the other  
requirements on a pass or fail basis. If the capacity ratio remains less than or 
equal to the D/C ratio limit, which is a number close to 1.0, and if the section 
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passes all of the special requirements, the section is considered to be adequate, 
else the section is considered to be failed. The D/C ratio limit is taken as 0.95 
by default. However, this value can be overwritten in the Preferences (Chapter 
3). 

To choose (design) the optional section from a predefined list, the program first 
orders the list of sections in increasing order of weight per unit length. Then it 
starts checking each section from the ordered list, starting with the one with 
least weight. The procedure for checking each section in this list for adequacy 
is exactly the same as described in the preceding paragraph. The program will 
evaluate each section in the list until it finds the least weight section that passes 
the code checks. If no section in the list is acceptable, the program will use the 
heaviest section but flag it as being overstressed. 

To check adequacy of an individual section, the user must assign the section 
using the Assign menu. In that case, both the analysis and design section will 
be changed. 

To choose the optimal section, the user must first define a list of steel sections, 
the Auto Select sections list. The user must next assign this list, in the same 
manner as any other section assignment, to the frame members to be optimized. 
The program will use the median section by weight when doing the initial 
analysis. Refer to the program Help for more information about Auto Select 
section lists. 

2.2 Analysis Sections vs. Design Sections 
Analysis sections are those section properties used to analyze the model when 
the analysis is run. The design section is whatever section is used in the steel 
frame design. It is possible for the last used analysis section and the current de-
sign section to be different. For example, an analysis may be run using a 
W18X35 beam, and then in the design, it may be found that a W16X31 beam 
worked. In that case, the last used analysis section is the W18X35 and the cur-
rent design section is the W16X31. Before the design process is complete, veri-
fy that the last used analysis section and the current design section are the 
same. Refer to the program Help for more information about completing this 
task. 
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The program keeps track of the analysis section and the design section sepa-
rately. Note the following about analysis and design sections: 

 Assigning a frame section property assigns the section as both the analysis 
section and the design section. 

 Running an analysis always sets the analysis section to be the same as the 
current design section. 

 Assigning an Auto Select section list to a frame object initially sets the 
analysis and design section to be the section in the list with the median 
weight. 

 Unlocking a model deletes the design results, but it does not delete or 
change the design section. 

 Altering the Design Combinations in any way deletes the design results, 
but does not delete or change the design section. 

 Altering any of the steel frame design preferences deletes the design re-
sults, but does not delete or change the design section. 

2.3 Design and Check Stations 
For each design combination, steel frame members (beams, columns, and brac-
es) are designed (optimized) or checked at a number of locations (stations) 
along the length of the object. The stations are located at equally spaced seg-
ments along the clear length of the object. By default, at least three stations will 
be located in a column or brace member, and the stations in a beam will be 
spaced at most 0.5 meter apart (2 feet if the model has been created in US 
units). The user can overwrite the number of stations in an object before the 
analysis is made using the Assign menu. The user can refine the design along 
the length of a member by requesting more stations. 
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2.4 Demand/Capacity Ratios 
Determination of the controlling D/C ratios for each steel frame member indi-
cates the acceptability of the member for the given loading conditions. The 
steps for calculating the D/C ratios are as follows: 

 The factored forces are calculated for axial, flexural, and shear at each de-
fined station for each design combination. The bending moments are calcu-
lated about the principal axes. For I-Shape, Box, Channel, T-Shape, Dou-
ble-Angle, Pipe, Circular, and Rectangular sections, the principal axes co-
incide with the geometric axes. For Single-Angle sections, the design con-
siders the principal properties. For General sections, it is assumed that all 
section properties are given in terms of the principal directions. 

For Single-Angle sections, the shear forces are calculated for directions 
along the geometric axes. For all other sections, the program calculates the 
shear forces along the geometric and principal axes. 

 The nominal strengths are calculated for compression, tension, bending 
and shear based on the equations provided later in this manual. For flexure, 
the nominal strengths are calculated based on the principal axes of bend-
ing. For the I-Shape, Box, Channel, Circular, Pipe, T-Shape, Double-Angle 
and Rectangular sections, the principal axes coincide with their geometric 
axes. For the Angle sections, the principal axes are determined and all 
computations related to flexural stresses are based on that. 

The nominal strength for shear is calculated along the geometric axes for 
all sections. For I-Shape, Box, Channel, T-Shape, Double-Angle, Pipe, 
Circular, and Rectangular sections, the principal axes coincide with their 
geometric axes. For Single-Angle sections, principal axes do not coincide 
with the geometric axes. 

 Factored forces are compared to nominal strengths to determine D/C ratios. 
In either case, design codes typically require that the ratios not exceed a 
value of one. A capacity ratio greater than one indicates a member that has 
exceeded a limit state. 
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2.5 Design Load Combinations 
The design load combinations are the various combinations of the prescribed 
analysis cases for which the structure needs to be checked. The program creates 
a number of default design load combinations for steel frame design. Users can 
add their own design combinations as well as modify or delete the program de-
fault design load combinations. An unlimited number of design load combina-
tions can be specified. 

To define a design load combination, simply specify one or more analysis cas-
es, each with its own scale factor.  The scale factors are applied to the forces 
and moments from the analysis cases to form the factored design forces and 
moments for each design load combination.   

For normal loading conditions involving static dead load (DL), live load (LL), 
wind load (WL), earthquake load (EL), notional load (NL), and dynamic re-
sponse spectrum load (EL), the program has built-in default design combina-
tions for the design code. These are based on the code recommendations.  

The default design combinations assume all static load response cases declared 
as dead or live to be additive.  However, each static load case declared as wind, 
earthquake, or response spectrum cases, is assumed to be non-additive with 
other loads and produces multiple lateral combinations.  Also static wind, 
earthquake and notional load responses produce separate design combinations 
with the sense (positive or negative) reversed. The notional load cases are add-
ed to load combinations involving gravity loads only. 

For other loading conditions involving moving load, time history, pattern live 
load, separate consideration of roof live load, snow load, and the like, the user 
must define the design load combinations in lieu of or in addition to the default 
design load combinations. If notional loads are to be combined with other load 
combinations involving wind or earthquake loads, the design load combina-
tions should be defined in lieu of or in addition to the default design load com-
binations. 

For multi-valued design combinations, such as those involving response spec-
trum, time history, moving loads and envelopes, where any correspondence  
between forces is lost, the program automatically produces sub-combinations 
using the maxima/minima values of the interacting forces. Separate combina-

 Design Load Combinations 2 - 5 



Steel Frame Design CSA S16-09 

tions with negative factors for response spectrum analysis cases are not  
required because the program automatically takes the minima to be the nega-
tive of the maxima response when preparing the sub-combinations described 
previously. 

The program allows live load reduction factors to be applied to the member 
forces of the reducible live load case on a member-by-member basis to reduce 
the contribution of the live load to the factored responses. 

2.6 Second Order P-Delta Effects 
Modern design provisions are based on the principle that the member forces are 
calculated by a second-order elastic analysis, where the equilibrium is satisfied 
on the deformed geometry of the structure. The effects of the loads acting on 
the deformed geometry of the structure are known as the second-order or the  
P-Delta effects.  

The P-Delta effects come from two sources: global lateral translation of the 
frame and the local deformation of members within the frame. 

Consider the frame object shown in Figure 2-1, which is extracted from a story 
level of a larger structure. The overall global translation of this frame object is 
indicated by ∆. The local deformation of the member is shown as δ. The total 
second order P-Delta effects on this frame object are those caused by both ∆  
and δ. 

The program has an option to consider P-Delta effects in the analysis. When 
you consider P-Delta effects in the analysis, the program does a good job of 
capturing the effect due to the ∆ deformation (P-∆ effect) shown in Figure  
2-1, but it does not typically capture the effect of the δ deformation (P-δ   
effect), unless, in the model, the frame object is broken into multiple elements 
over its length. 

In design codes, required strengths are usually required to be determined using 
a second-order analysis that considers both P-∆  and P-δ  effects. Approximate 
second-order analysis procedures based on amplification of responses from 
first-order analysis for calculating the required flexural and axial strengths are 
common in current design codes and have the following general form: 
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∆

δ

Original position of frame
element shown by vertical
line

Position of frame element
as a result of global lateral
translation, ∆, shown by
dashed line

Final deflected position of
frame element that
includes the  global lateral
translation, ∆, and the
local deformation of the
element, δ

 

Figure 2-1 P-∆  and P-δ  effects 

 

( )1 2= +CAP nt ltM U M U M  (CSA 8.7.1, 13.8.4) 

where, 

CAPM  =  Required flexural design capacities 

ntM  = Required flexural capacities from first-order analysis of the 
member assuming there is no translation of the frame (i.e., asso-
ciated with the δ deformation in Figure 2-1) 

ltM  = Required flexural capacities from first-order analysis of the 
member as a result of lateral translation of the frame only (i.e., 
associated with the ∆ deformation in Figure 2-1) 

1U  = Unitless amplification factor multiplying ntM  

2U  = Unitless amplification factor multiplying ( )2+nt ltM U M  

A rigorous second order analysis or the amplification of first order analysis  
results to estimate the effect of second order effects is required (CSA 8.7.1, 
13.8.4). The program has the capability of performing both. In the first case, 
the required strengths are determined directly from the analysis results without 
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any amplification factors (i.e., U1 and U2 are equal to 1). However, these ampli-
fication factors can always be overwritten by the user on a member-by-member 
basis, if desired, using the overwrite option. 

To properly capture the P-δ effect in a finite element analysis, each element, 
especially column elements, must be broken into multiple finite elements, 
which is not really desired for other reasons. Although a single element per 
member can capture the P-δ effect to some extent, the program considers that 
inadequate. The program thus uses the U1 factor even if the analysis considers 
the P-∆ effects. This is a conservative approach. 

Thus, in general, the steel frame design feature requires consideration of  
P-Delta effects in the analysis before the check/design is performed. Although 
one element per line object is generally adequate to capture the P-∆ effect, it is 
recommended to use more than one element per line object for the cases where 
both P-∆ and P-δ effects are to be considered. However, explicit manual break-
ing of the member into elements has other consequences related to member end 
moments and unbraced segment end moment. It is recommended that the 
members be broken internally by the program. In this way, the member is  
recognized as one unit, end of the members are identified properly, and P-∆ 
and P-δ  effects are captured better. 

2.7 Notional Load Cases 
Notional loads are lateral loads that are applied at each framing level and are 
specified as a percentage of the gravity loads applied at that level (CSA 8.7.2). 
These are intended to account for the destabilizing effects of out-of-plumbness, 
geometric imperfections, inelasticity in structural members, and any other  
effects that could induce sway and that are not explicitly considered in the 
analysis. 

The program allows the user to create a Notional Load case as a percentage of 
the previously defined gravity load case to be applied in one of the global lat-
eral directions:  X or Y. The user can define more than one notional load case 
associated with one gravity load by considering different factors and different 
directions.  
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Currently, the notional loads are not automatically included in the default de-
sign load combinations that include lateral loads. However, the user is free to 
modify the default design load combinations to include the notional loads with 
appropriate factors and in appropriate load combinations. 

2.8 Member Unsupported Lengths 
The column unsupported lengths are required to account for column slender-
ness effects for flexural buckling and for lateral-torsional buckling.  The pro-
gram automatically determines the unsupported length ratios, which are speci-
fied as a fraction of the frame object length.  Those ratios times the frame ob-
ject lengths give the unbraced lengths for the member.  Those ratios also can be 
overwritten by the user on a member-by-member basis, if desired, using the de-
sign overwrite option. The unsupported length for minor direction bending or 
for lateral-torsional buckling also can be defined more precisely by using pre-
cise bracing points in the Lateral Bracing option; refer to the program Help for 
more information about lateral bracing. If the unsupported length is defined us-
ing the precise bracing point definition and if it is also overwritten in the over-
writes, the value used in the design overwrites prevails. 

Two unsupported lengths, L33 and L22, as shown in Figure 2-2 are to be consid-
ered for flexural buckling. These are the lengths between support points of the 
member in the corresponding directions.  The length L33 corresponds to insta-
bility about the 3-3 axis (major axis), and L22  corresponds to instability about 
the 2-2 axis (minor axis).  The length LLTB (also termed Lz), not shown in the 
figure, is also used for lateral-torsional buckling caused by major direction 
bending (i.e., about the 3-3 axis). 

In determining the values for L22 and L33 of the members, the program recog-
nizes various aspects of the structure that have an effect on these lengths, such 
as member connectivity, diaphragm constraints, and support points.  The pro-
gram automatically locates the member support points and evaluates the corre-
sponding unsupported length. 
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Figure 2-2 Unsupported lengths L33 and L22  

It is possible for the unsupported length of a frame object to be evaluated by 
the program as greater than the corresponding member length. For example, 
assume a column has a beam framing into it in one direction, but not the other, 
at a floor level.  In that case, the column is assumed to be supported in one di-
rection only at that story level, and its unsupported length in the other direction 
will exceed the story height. 

By default, the unsupported length for lateral-torsional buckling, LLTB, is taken 
to be equal to the L22 factor. Similar to L22 and L33, LLTB can be overwritten. 

2.9 Effects of Breaking a Member into Multiple Elements 
The preferred method is to model a beam, column or brace member as one sin-
gle element. However, the user can request that the program break a member 
internally at framing intersections and at specified intervals. In this way, accu-
racy in modeling can be maintained at the same time that design/check specifi-
cations can be applied accurately. There is special emphasis on the end forces 
(moments in particular) for many different aspects of beam, column, and brace 
design. If the member is manually meshed (broken) into segments, maintaining 
the integrity of the design algorithm becomes difficult. 
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Manually breaking a column member into several elements can affect many 
things during design in the program.  

1. The unbraced length:  The unbraced length is really the unsupported length 
between braces. If no intermediate brace is present in the member, the un-
braced length is typically calculated automatically by the program from the 
top of the flange of the beam framing the column at the bottom to the bot-
tom of the flange of the beam framing the column at the top. The automati-
cally calculated length factor typically becomes less than 1. If there are in-
termediate bracing points, the user should overwrite the unbraced length 
factor in the program. The user should choose the critical (larger) one. 
Even if the user breaks the element, the program typically picks up the un-
braced length correctly, provided that there is no intermediate bracing 
point. 

2. K-factor: Even if the user breaks the member into pieces, the program typi-
cally can pick up the K-factors correctly. However, sometimes it can not. 
The user should note the K-factors. All segments of the member should 
have the same K-factor and that factor should be calculated based on the 
entire member. If the calculated K-factor is not reasonable, the user can 
overwrite the K-factors for all the segments. 

3. ω1 factor: The ω1 factor should be based on the end moments of unbraced 
lengths of each segment and should not be based on the end moments of 
the member (CSA 13.8.4). The program already calculates the ω1 factors 
based on the end moments of unbraced lengths of each segment. If the 
break-up points are the brace points, no action is required by the user. If the 
broken segments do not represent the brace-to-brace unsupported length, 
the program calculated ω1 factor is conservative. If this conservative value 
is acceptable, no action is required by the user. If it is not acceptable, the 
user can calculate the ω1 factor manually for the critical combination and 
overwrite its value for that segment. 

4. ω2 factor:  The logic is similar to that for the ω1 factor. 

5. U1 factor:  This factor amplifies the factored moments for the P-δ effect 
(CSA 13.8.4). In its expression, there are the ω1 factor and the Euler Buck-
ling capacity Pe. If the user keeps the unbraced length ratios (L33 and L22) 
and the K-factors (K33 and K22) correct, the U1 factor would be correct. If 
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the axial force is small, the U1 factor can be 1 and have no effect with re-
spect to modeling the single segment or multi-segment element. 

6. U2 factor: The program does not calculate the U2 factor. The program  
assumes that the user turns on the P-∆ feature. In such cases, U2 can be 
taken as equal to 1 (CSA 8.7.1). That means that modeling with one or 
with multiple segments has no effect on this factor. 

If the user models a column with a single element and makes sure that the  
L-factors and K-factors are correct, the effect of U1 and U2 will be picked up 
correctly. The factors ω1 and ω2 will be picked up correctly if there is no inter-
mediate bracing point. The calculated ω1 and ω2 factors will be slightly con-
servative if there are intermediate bracing points. 

If the user models a column with multiple elements and makes sure that  
L-factors and K-factor are correct, the effect of U1 and U2 will be picked up  
correctly. The factors ω1 and ω2 will be picked up correctly if the member is 
broken at the bracing points. The calculated ω1 and ω2 factors will be conserva-
tive if the member is not broken at the bracing points. 

2.10 Effective Length Factor (K) 
The effective length method for calculating member axial compressive strength 
has been used in various forms in several stability based design codes. The 
method originates from calculating effective buckling lengths, KL, and is based 
on elastic/inelastic stability theory. The effective buckling length is used to cal-
culate an axial compressive strength, Cr, through an empirical column curve 
that accounts for geometric imperfections, distributed yielding, and residual 
stresses present in the cross-section.  

The K-factor is used for calculating the Euler axial capacity assuming that all 
the beam-column joints are free to sway, i.e., lateral translation is allowed. The 
resulting axial capacity is used in calculating Cr. The K-factor is always greater 
than 1 if the frame is a sway frame. The program calculates the K-factor auto-
matically based on sway condition. The program also allows the user to over-
write K-factors on a member-by-member basis. The same K-factor is supposed 
to be used in calculation of the U2 factor. However the program does not calcu-
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late U2 factors and relies on the overwritten values. If the frame is not really a 
sway frame, the user should overwrite the K-factors. 

K has two values:  one for major direction, Kmajor, and the other for minor direc-
tion, Kminor,. 

There is another K-factor. Kltb for lateral torsional buckling. By default, Kltb is 
taken as equal to Kminor. However the user can overwrite this on a member-by-
member basis.  

The rest of this section is dedicated to the determination of K-factors. 

The K-factor algorithm has been developed for building-type structures, where 
the columns are vertical and the beams are horizontal, and the behavior is basi-
cally that of a moment-resisting frame for which the K-factor calculation is rel-
atively complex. For the purpose of calculating K-factors, the objects are iden-
tified as columns, beam and braces. All frame objects parallel to the Z-axis are 
classified as columns. All objects parallel to the X-Y plane are classified as 
beams.  The remainders are considered to be braces. 

The beams and braces are assigned K-factors of unity. In the calculation of the  
K-factors for a column object, the program first makes the following four stiff-
ness summations for each joint in the structural model: 

 =  
 ∑ c c

cx
c x

E IS
L

 b b
bx

b x

E IS
L
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c c
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c y
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 =  
 ∑  b b

b y
b y
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 =  
 ∑  

where the x and y subscripts correspond to the global X and Y directions and 
the c and b subscripts refer to column and beam. The local 2-2 and 3-3 terms 

22 22EI L  and 33 33EI L  are rotated to give components along the global X and 
Y directions to form the ( )x

EI L  and ( )y
EI L  values. Then for each column, 

the joint summations at END-I and the END-J of the member are transformed 
back to the column local 1-2-3 coordinate system, and the G-values for END-I 
and the END-J of the member are calculated about the 2-2 and 3-3 directions 
as follows: 
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If a rotational release exists at a particular end (and direction) of an object, the 
corresponding value of G is set to 10.0. If all degrees of freedom for a particu-
lar joint are deleted, the G-values for all members connecting to that joint will 
be set to 1.0 for the end of the member connecting to that joint. Finally, if IG  
and JG  are known for a particular direction, the column K-factor for the corre-
sponding direction is calculated by solving the following relationship for α: 

α
αα

tan)(6
362

=
+

−
JI

JI

GG
GG  

from which K = π/α. This relationship is the mathematical formulation for the 
evaluation of K-factors for moment-resisting frames assuming sidesway to be 
uninhibited. For other structures, such as braced frame structures, the K-factors 
for all members are usually unity and should be set so by the user. The follow-
ing are some important aspects associated with the column K-factor algorithm: 

 An object that has a pin at the joint under consideration will not enter the 
stiffness summations calculated previously. An object that has a pin at the 
far end from the joint under consideration will contribute only 50% of the 
calculated EI value. Also, beam members that have no column member at 
the far end from the joint under consideration, such as cantilevers, will not 
enter the stiffness summation.  

 If there are no beams framing into a particular direction of a column mem-
ber, the associated G-value will be infinity. If the G-value at any one end 
of a column for a particular direction is infinity, the K-factor corresponding 
to that direction is set equal to unity.  

 If rotational releases exist at both ends of an object for a particular direc-
tion, the corresponding K-factor is set to unity.  

 The automated K-factor calculation procedure occasionally can generate 
artificially high K-factors, specifically under circumstances involving 
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skewed beams, fixed support conditions, and under other conditions where 
the program may have difficulty recognizing that the members are laterally 
supported and K-factors of unity are to be used.  

 All K-factor produced by the program can be overwritten by the user. 
These values should be reviewed and any unacceptable values should be 
replaced. 

 The beams and braces are assigned K-factors of unity. 

2.11 Supported Framing Types 
The code (CSA S16-09) recognizes the following types of framing systems. 

Framing Type References 

Type LD MRF (Limited-Ductility Moment-Resisting Frame) CSA  27.4 

Type MD MRF (Moderate-Ductility Moment-Resisting Frame) CSA  27.3 

Type D MRF (Ductile Moment-Resisting Frame) CSA 27.2 

Type LD CBF(V), (Limited-Ductility Concentrically Braced Frame – Chevron) CSA 27.6.2.2 

Type LD CBF(TC) (Limited-Ductility Ductile Concentrically Braced Frame – Tension-Compression) CSA 27.6.2.1 

Type LD CBF(TO), (Limited-Ductility Ductile Concentrically Braced Frame – Tension only) CSA 27.6.2.3 

Type LD CBF(OT), (Limited-Ductility Ductile Concentrically Braced Frame – Others) CSA 27.6.3 

Type MD CBF(V), (Moderately Ductile Concentrically Braced Frame – Chevron) CSA 27.5.2.4 

Type MD CBF(TC), (Moderately Ductile Concentrically Braced Frame – Tension-Compression) CSA 27.5.2.3 

Type MD CBF(TO), (Moderately Ductile Concentrically Braced Frame – Tension only) CSA 27.5.2.5 

Type MD CBF(OT), (Moderately Ductile Concentrically Braced Frame – Others) CSA 27.5.3.2 

EBF, (Ductile Eccentric Braced Frame) CSA 27.7 

Conventional MF CSA 27.10 

Conventional BF CSA 27.10 

2.12 Continuity Plates 
In a plan view of a beam/column connection, a steel beam can frame into a 
column in the following ways: 
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 The steel beam frames in a direction parallel to the column major direction, 
i.e., the beam frames into the column flange. 

 The steel beam frames in a direction parallel to the column minor direc-
tion, i.e., the beam frames into the column web. 

 The steel beam frames in a direction that is at an angle to both of the prin-
cipal axes.  

To achieve a beam/column moment connection, continuity plates, such as 
shown in Figure 2-3, are usually placed on the column, in line with the top and 
bottom flanges of the beam, to transfer the compression and tension flange 
forces of the beam into the column. 

For connection conditions described in the last two bullet items, the thickness 
of such plates is usually set equal to the flange thickness of the corresponding 
beam. 

However, for the connection condition described by the first bullet item, where 
the beam frames into the flange of the column, such continuity plates are not 
always needed. The requirement depends upon the magnitude of the beam 
flange force and the properties of the column. 

The program investigates whether the continuity plates are needed based on the 
requirements of the selected code. Columns of I-sections supporting beams of 
I-sections only are investigated. The program evaluates the continuity plate re-
quirements for each of the beams that frame into the column flange and reports 
the maximum continuity plate area that is needed for each beam flange.  The 
continuity plate requirements are evaluated for moment frames only. 
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Figure 2-3 Doubler Plates and Continuity Plates 
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2.13 Doubler Plates 
One aspect of the design of a steel framing system is an evaluation of the shear 
forces that exist in the region of the beam-column intersection known as the 
panel zone. Shear stresses seldom control the design of a beam or column 
member.  However, in a moment resisting frame, the shear stress in the beam-
column joint can be critical, especially in framing systems when the column is 
subjected to major direction bending and the web of the column resists the joint 
shear forces.  In minor direction bending, the joint shear is carried by the col-
umn flanges, in which case the shear stresses are seldom critical, and the pro-
gram does therefore not investigate this condition. 

Shear stresses in the panel zone due to major direction bending in the column 
may require additional plates to be welded onto the column web, depending 
upon the loading and the geometry of the steel beams that frame into the 
column, either along the column major direction, or at an angle so that the 
beams have components along the column major direction. See Figure 3-3. 
When code appropriate, the program investigates such situations and reports 
the thickness of any required doubler plates.  Only columns with I-shapes and 
only supporting beams with I-shapes are investigated for doubler plate 
requirements.  Also, doubler plate requirements are evaluated for moment 
frames only.  

2.14 Frame Design Procedure Overwrites 
The structural model may contain frame elements made of several structural 
materials:  steel, concrete, aluminum, cold-formed steel and other materials. 
The program supports separate design procedures for each material type. By 
default the program determines the design procedure from the material of the 
frame member. 

The program allows the user to turn the design of specific members off and on 
by selecting No Design or Default from material. Refer to the program Help 
form more information about overwriting the design procedure. 

ETABS supports both regular steel frame design and composite beam design. 
The determination of design procedure is different. If the material is concrete, 
the design procedure is concrete. If the material is steel, the default design pro-
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cedure can be steel frame design or composite beam design. If the section is of 
steel material, and the member satisfies a host of other criteria, such as the 
member is horizontal (beam), it supports a filled deck or slab, it is an I-shaped 
member, it is hinged at both ends and so on, then the default design procedure 
is taken as composite beam design; otherwise, the default design procedure is 
taken as steel frame design. ETABS allows the user to overwrite a steel mem-
ber frame design procedure to steel frame design, composite beam design, de-
fault, or no design. Refer to the program Help for more information about 
changing the design procedure. A change in design will be successful only if 
the design procedure is valid for that member, i.e., the program will not allow 
the user to change the design procedure for a steel frame object to concrete 
frame design. 

2.15 Interactive Design 
Interactive Design is a powerful mode that allows the user to review the design 
results for any steel frame design and interactively revise the design assump-
tions and immediately review the revised results. Note that a design must have 
been run for the interactive design mode to be available.  Refer to the program 
Help for more information about interactive design. 

2.16 Automated Iterative Design 
If Auto Select sections have been assigned to frame objects, ETABS can auto-
matically perform the iterative steel frame design process. To initiate the pro-
cess in ETABS, first use the Design menu > Steel Frame Design > 
View/Revise Preferences command and set the maximum number of auto it-
erations to the maximum number of design iterations the program is to run au-
tomatically. Next, run the analysis. Then, begin the design, making sure that no 
objects are selected. 

The program will then start the cycle of (1) performing the design, (2) compar-
ing the last-used Analysis Sections with the Design Sections, (3) setting the 
Analysis Sections equal to the Design Sections, and (4) rerunning the analysis. 
This cycle will continue until one of the following conditions has been met: 

 The Design Sections and the last-used Analysis Sections are the same. 

 The number of iterations performed is equal to the number of iterations 
specified for the maximum number on the Preferences form. 
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Chapter 3 
Design using CSA S16-09  

This chapter provides a detailed description of the algorithms used by the pro-
grams in the design/check of structures in accordance with “CSA S16-09 —
Design of Steel Structures” (CSA 2009). The implementation covers load 
combinations from “CSA S16-09,” which is described in Section 3.4 Design 
Loading Combinations in this chapter. The loading based on "NBCC 2010" has 
been described in a separate document entitled “Automated Lateral Loads 
Manual” (CSI 2011).  

For referring to pertinent sections of the corresponding code, a unique prefix is 
assigned for each code. 

• Reference to the CSA S16-09 code is identified with the prefix “CSA.” 

• Reference to the NBCC 2010 code is identified with the prefix “NBCC.” 

3.1 Notations 
The various notations used in this manual are described herein. 

A Cross-sectional area, mm2 

Ae Effective cross-sectional area for slender sections, mm2 
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Ag Gross cross-sectional area, mm2 

Av2, Av3 Major and minor shear areas, mm2 

Aw Shear area, equal dtw per web, mm2 

Ce Euler buckling strength, N 

Cf Factored compressive axial load, N 

Cr Factored compressive axial strength, N 

Cw Warping constant, mm6 

Cy Compressive axial load at yield stress, AgFy, N 

D Outside diameter of pipes, mm  

E Modulus of elasticity, N/mm2  

Fcre Elastic critical plate-buckling stress in shear, N-sq-mm 

Fcri Inelastic critical plate-buckling stress in shear, N-sq-mm 

Fs Ultimate stress, N-sq-mm 

Fy Specified minimum yield stress of material, N/mm2  

G Shear modulus, N/mm2  

I22 Minor moment of inertia, mm4  

I33 Major moment of inertia, mm4  

J St. Venant torsional constant for the section, mm4  

K Effective length factor 

K33, K22 Effective length K-factors in the major and minor directions  

Kz Effective length K-factor for lateral torsional buckling 

L Laterally unbraced length of member, mm 

L22, L33 Laterally unbraced length of member for major and minor axes 
bending, mm 
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Lz Unbraced length for lateral-torsional buckling, mm 

Mf33, Mf22 Factored bending loads in major and minor directions, N-mm  

Mp33, Mp22 Plastic moments in major and minor directions, N-mm  

Mr33, Mr22 Factored moment resistance in major and minor directions,  
N-mm  

Mu Critical elastic moment, N-mm 

My33, My22 Yield moments in major and minor directions, N-mm  

S33,S22 Major and minor elastic section moduli, mm3 

Tf Factored tensile axial load, N 

Tr Factored tensile resistance, N 

U1 Moment magnification factor to account for deformation of 
member between ends (P-δ effect) 

U2 Moment magnification factor (on sidesway moments) to account 
for P-∆ 

Vf2, Vf3 Factored major and minor shear loads, N 

Vr2, Vr3 Factored major and minor shear resistance, N 

Z Plastic modulus, mm3 

Z33, Z22 Major and minor plastic moduli, mm3 

b Nominal dimension of plate in a section, mm  
longer leg of angle sections, bf  − 2tw for welded and bf  − 3tw for 
rolled box sections, and the like 

be Effective width of flange, mm  

bel Width of stiffened or unstiffened compression elements, mm  

bf Flange width, mm 

d Overall depth of member, mm  

h Clear distance between flanges less fillets, taken as (d − 2tf), mm 
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k Distance from outer face of flange to web toe of fillet, mm  

r Radius of gyration, mm 

r33, r22 Radii of gyration in the major and minor directions, mm 

rz Least radian of gyration for analysis sections, mm 

t Thickness, mm 

tf Flange thickness, mm 

tw Thickness of web, mm 

β Coefficient used in an interaction equation 

λ Slenderness parameter 

φ Resistance factor (clause 2.1, 13.1) 

ω1 Moment coefficient 

ω 12, ω 13 Moment coefficient in major and minor directions 

ω 2 Bending coefficient 

3.2 Design Preferences 
The steel frame design preferences are basic assignments that apply to all of 
the steel frame members. Table 3-1 lists steel frame design preferences for 
"CSA S16-09." Default values are provided for all preference items. Thus, it is 
not necessary to specify or change any of the preferences. However, at least re-
view the default values to ensure they are acceptable. Some of the preference 
items also are available as member-specific Overwrite items. The overwrites 
are described in the next section. Overwritten values take precedence over the 
preferences. Refer to the program Help for information about changing Preferences. 

Table 3-1: Steel Frame Design Preferences 
Item Possible Values Default Value Description 

Design Code  Design codes  
available in the  
current version 

AISC360-05/ 
IBC 2006 

The selected design code. Subsequent design is based 
on this selected code. 
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Table 3-1: Steel Frame Design Preferences 
Item Possible Values Default Value Description 

Multi-Response Case 
Design 

 Envelopes,    
Step-by-Step, Last 
Step, Envelopes, 
All, Step-by-Step - 
All 

Envelopes Select to indicate how results for multivalued cases 
(Time history, Nonlinear static or Multi-step static) 
are considered in the design.  - Envelope - considers 
enveloping values for Time History and Multi-step 
static and last step values for Nonlinear static. Step-
by-Step - considers step by step values for Time 
History and Multi-step static and last step values for 
Nonlinear static. Last Step - considers last values for 
Time History, Multi-step static and Nonlinear static. 
Envelope - All - considers enveloping values for 
Time History, Multi-step static and Nonlinear static. 
Step-by-Step - All - considers step by step values for 
Time History, Multi-step static and Nonlinear static. 
Step-by-Step and Step-by-Step - All default to the 
corresponding Envelope if more then one multi-
valued case is present in the combo. 

Framing Type Type LD MRF,  
Type MD MRF,  
Type D MRF,  
Type LD CBF(V),  
Type LD CBF(TC), 
Type LD CBF(TO), 
Type LD CBF(OT), 
Type MD CBF(V), 
Type MD CBF(TC),  
Type MD CBF(TO), 
Type MD CBF(OT), 
EBF, Cantilever,  
Column, Conventional 
MF, Conventional BF 

Type LD MRF This item is used for ductility considerations in the 
design. 

Spectral Acceleration 
Ratio, Ie*Fa*Sa(0.2) 

> 0 0.35 This is Sa(T=0.2sec) multiplied by IE=e and Fa.  It 
can assume different values in two orthogonal direc-
tions.  The value specified here is solely used for 
design.  The program uses the same value for all 
directions.  See CSA S16-09/CSA S16-01/S16S1-05 
section 27.1.1, NBCC section 4.1.8.2, Table 4.1.8.9, 
Table 4.1.8.5, and Table 4.1.8.4B for details.   

Ductility Related 
Modification Factor, 
Rd 

> 0 5 Overstrength-related force modification factor  
reflecting the capability of a structure to dissipate 
energy through inelastic behavior. This is a function 
of Seismic Force Resisting System.  It can assume 
different values in two orthogonal directions.  The 
program uses the same value for all directions.  The 
value specified here is solely used for design.  See 
CSA S16-09/CSA S16-01/S16S1-05 section 27.1.1, 
NBCC sections 4.1.8.2 and 4.1.8.9, and NBCC Table 
4.1.8.9 for details 
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Table 3-1: Steel Frame Design Preferences 
Item Possible Values Default Value Description 

Overstrength Related 
Modification Factor 

> 0 1.5 This accounts for the dependable portion of reserve 
strength in a structure.  This is a function of Seismic 
Force Resisting System.  It can assume different 
values in two orthogonal directions.  The program 
uses the same value for all directions.  The value 
specified here is solely used for design.  See CSA 
S16-09/CSA S16-01/S16S1-05 section 27.1.1, 
NBCC sections 4.1.8.2 and 4.1.8.9, and NBCC Table 
4.1.8.9 for details.   

Phi (Bending) ≤1.0 0.9 Strength reduction factor. 

Phi (Compression) ≤1.0 0.9 Strength reduction factor. 

Phi (Tension) ≤1.0 0.9 Strength reduction factor. 

Phi (Shear) ≤1.0 0.9 Strength reduction factor. 

Slender Section  
Modification 

Modify Geometry, 
Modify Fy 

Modify  
Geometry 

Select if the Class 4 sections should be handled by 
modifying the geometry or by modifying fy.  

Ignore Seismic Code? Yes, No No Toggle to consider (No) or not consider (Yes) the 
seismic part of the code in design. 

Ignore Special  
Seismic Load? 

Yes, No No Toggle to consider (No) or not consider (Yes) special 
seismic load combinations in design. 

Is Doubler Plate Plug 
Welded? 

Yes, No Yes Toggle to indicate if the doubler-plate is plug welded 
(Yes), or it is not plug welded (No). 

Consider  
Deflection? 

Yes, No Yes Toggle to consider the deflection limit (Yes) or to not 
consider the deflection limit (No). 

DL Limit, L/  ≥ 0 120 Deflection limit for dead load. Inputting 120 means 
that the limit is L/120. Inputting zero means no check 
will be made of this item. 

Super DL+LL  Limit, L/  ≥ 0 120 Deflection limit for superimposed dead plus live 
load. Inputting 120 means that the limit is L/120. 
Inputting zero means no check will be made of this 
item. 

Live Load Limit, L/  ≥ 0 360 Deflection limit for superimposed live load. Inputting 
360 means that the limit is L/360. Inputting zero 
means no check will be made of this item. 

Total Limit, L/  ≥ 0 240 Deflection limit for total load. Inputting 240 means 
that the limit is L/240. Inputting zero means no check 
will be made of this item. 

Total-Camber Limit, L/  ≥ 0 240 Limit for net deflection. Camber is subtracted from 
the total load deflection to get net deflection. Input-
ting 240 means that the limit is L/240. Inputting zero 
means no check will be made of this item. 
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Table 3-1: Steel Frame Design Preferences 
Item Possible Values Default Value Description 

Pattern Live Load  
Factor 

 ≤1.0 0.75 The live load factor for automatic generation of load 
combinations involving pattern live loads and dead 
loads. 

Demand/Capacity 
Ratio Limit 

 ≤1.0 0.95 The demand/capacity ratio limit to be used for ac-
ceptability.  D/C ratios that are less than or equal to 
this value are considered acceptable. 

3.3 Overwrites 
The steel frame design Overwrites are basic assignments that apply only to 
those elements to which they are assigned. Table 3-2 lists steel frame design 
overwrites for "CSA S16-09." Default values are provided for all Overwrite 
items. Thus, it is not necessary to specify or change any of the Overwrites. 
However, at least review the default values to ensure they are acceptable. 
When changes are made to Overwrite items, the program applies the changes 
only to the elements to which they are specifically assigned. Overwritten val-
ues take precedence over the Preferences. Refer to the program Help for infor-
mation about changing Overwrites. 

Table 3-2 Steel Frame Design Overwrites for "CSA S16-09" 
Item Possible Values Default Value Description 

Current Design 
Section 

 Any defined steel 
section 

Analysis  
section 

The design section for the selected frame object. 
When this Overwrite is applied, any previous auto 
select section assigned to the frame object is  
removed. 

Fame Type Type LD MRF,  
Type MD MRF,  
Type D MRF,  
Type LD CBF(V),  
Type LD CBF(TC), 
Type LD CBF(TO), 
Type LD CBF(OT), 
Type MD CBF(V), 
Type MDCBF(TC),  
Type MD CBF(TO), 
Type MD CBF(OT), 
EBF, Cantilever,  
Column, Conventional 
MF, Conventional BF 

From  
Preferences 

This item is used for ductility considerations in the 
design. 
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Table 3-2 Steel Frame Design Overwrites for "CSA S16-09" 
Item Possible Values Default Value Description 

Consider Deflection?  Yes/No No Toggle to consider (Yes) or not consider (No) deflec-
tion. 

Deflection Check 
Type 

 Ratio,  
 Absolute,  
 Both 

Program  
Determined 

Choose to consider deflection limitations as absolute, 
as a divisor of the beam length (relative),  as both. 

DL Limit, L/  ≥ 0 Program  
Determined 

Deflection limit for dead load. Inputting 120 means 
that the limit  is L/120. Inputting zero means no 
check will be made of this item. 

Super DL+LL  
Limit, L/ 

 ≥ 0 Program  
Determined 

Deflection limit for superimposed dead plus live 
load. Inputting 120 means that the limit  is L/120. 
Inputting zero means no check will be made of this 
item. 

Live Load Limit, L/  ≥ 0 Program  
Determined 

Deflection limit for superimposed live load. Inputting 
360 means that the limit is L/360. Inputting zero 
means no check will be made of this item. 

Total Limit, L/  ≥ 0 Program  
Determined 

Deflection limit for total load. Inputting 240 means 
that the limit is L/240. Inputting zero means no check 
will be made of this item. 

Total-Camber Limit, 
L/ 

 ≥ 0 Program  
Determined 

Limit for net deflection. Camber is subtracted from 
the total load deflection to get net deflection. Input-
ting 240 means that the limit is L/240. Inputting zero 
means no check will be made of this item. 

DL Limit, abs  ≥ 0 Program  
Determined 

Deflection limit for dead load. Inputting zero means 
no check will be made of this item. 

Super DL+LL Limit, 
abs 

 ≥ 0 Program  
Determined 

Deflection limit for superimposed dead plus live 
load. Inputting zero means no check will be made of 
this item. 

Live Load Limit, abs  ≥ 0 Program  
Determined 

Deflection limit for superimposed live load. Inputting 
zero means no check will be made of this item. 

Total Limit, abs  ≥ 0 Program  
Determined 

Deflection limit for total load. Inputting zero means 
no check will be made of this item. 

Total–Camber Limit, 
abs 

 ≥ 0 Program  
Determined 

Deflection limit for net deflection.  Camber is sub-
tracted from the total load deflection to get net  
deflection. Inputting a value of 240 means that the 
limit is L/240.  Inputting zero means no check will be 
made of this item. 

Specified Camber  ≥ 0 Program  
Determined 

The specified amount of camber to be reported in the 
design output and to be used in the net deflection 
check. 

Net Area to Total 
Area Ratio 

 ≥ 0 Program  
Determined 

The ratio of the net area at the design section to gross 
cross-sectional area of the section. This ratio affects 
the design of axial tension members. Specifying 0 
means the value is program default which is 1. 
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Table 3-2 Steel Frame Design Overwrites for "CSA S16-09" 
Item Possible Values Default Value Description 

Live Load Reduction 
Factor 

 ≥ 0 Program  
Determined 

The reducible live load is multiplied by this factor to 
obtain the reduced live load for the frame object. 
Specifying zero means the value is program deter-
mined. 

Unbraced Length 
Ratio (Major) 

 ≥ 0 Program  
Determined 

Unbraced length factor for buckling about the frame 
object major axis; specified as a fraction of the frame 
object length. This factor times the frame object 
length gives the unbraced length for the object. Spec-
ifying zero means the value is program determined. 

Unbraced Length 
Ratio (Minor, LTB) 

 ≥ 0 Program  
Determined 

Unbraced length factor for buckling about the frame 
object minor axis; specified as a fraction of the frame 
object length. This factor times the frame object 
length gives the unbraced length for the object. Spec-
ifying zero means the value is program determined. 

Unbraced Length 
Ratio (LTB) 

 ≥ 0 Program  
Determined 

Unbraced length factor for lateral-torsional buckling 
for the frame object; specified as a fraction of the 
frame object length. This factor times the frame 
object length gives the unbraced length for the ob-
ject. Specifying zero means the value is program 
determined. 

Effective Length 
Factor (K Major) 

 ≥ 0 Program  
Determined 

Effective length factor for buckling about the frame 
object major axis; specified as a fraction of the frame  
object length. This factor times the frame object 
length gives the effective length for the object.  Spec-
ifying zero means the value is program determined. 
For beam design, this factor is always taken as 1, 
regardless of any other value specified in the Over-
writes.  This factor is used for the B1 factor. 

Effective Length 
Factor (K Minor) 

 ≥ 0 Program  
Determined 

Effective length factor for buckling about the frame 
object minor axis; specified as a fraction of the frame  
object length. This factor times the frame object 
length gives the effective length for the object.  Spec-
ifying zero means the value is program determined. 
For beam design, this factor is always taken as 1, 
regardless of any other value specified in the Over-
writes. This factor is used for the U1 factor. 

Effective Length 
Factor ( LTB) 

 ≥ 0 Program  
Determined 

Effective length factor for lateral-torsional buckling; 
specified as a fraction of the frame object length. 
This factor times the frame object length gives the 
effective length for the object. Specifying zero means 
the value is program determined. For beam design, 
this factor is taken as 1 by default. The values should 
be set by the user. 

Moment Coefficient 
(Omega1 Major) 

 ≥ 0 Program  
Determined 

Unitless factor; Omega1 for major axis bending is 
used in determining the interaction ratio. It captures 
the effect of non-uniform moment distribution along 
the length. Inputting zero means the value is program 
determined. 
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Table 3-2 Steel Frame Design Overwrites for "CSA S16-09" 
Item Possible Values Default Value Description 

Moment Coefficient 
(Omega1 Minor) 

 ≥ 0 Program  
Determined 

Unitless factor; Omega1 for minor axis bending is 
used in determining the interaction ratio.  It captures 
the effect of non-uniform moment distribution along 
the length. Inputting zero means the value is program 
determined. 

Bending Coefficient 
(Omega2) 

 ≥ 0 Program  
Determined 

Unitless factor; Omega2 is used in determining the 
interaction ratio.  It captures the effect of non-
uniform moment distribution along the length. Input-
ting zero means the value is program determined. 

NonSway Moment 
Factor (U1 Major) 

 ≥ 0 Program  
Determined 

Unitless moment magnification factor for non-sway 
major axis bending moment. Specifying zero means 
the value is program determined. 

NonSway Moment 
Factor (U1 Minor) 

 ≥ 0 Program  
Determined 

Unitless moment magnification factor for non-sway 
minor axis bending moment. Specifying zero means 
the value is program determined. 

Sway Moment  
Factor (U2 Major) 

 ≥ 0 Program  
Determined 

Unitless moment magnification factor for sway  
major-axis bending moment. Specifying zero means 
the value is program determined. The program de-
termined value is taken as 1 because it is assumed 
that P-delta effects were specified to be included in 
the analysis, and thus no further magnification is 
required. 

Sway Moment  
Factor (U2 Minor) 

 ≥ 0 Program  
Determined 

Unitless moment magnification factor for sway  
major-axis bending moment. Specifying zero means 
the value is program determined. The program  
determined value is taken as 1 because it is assumed 
that P-Delta effects were specified to be included in 
the analysis, and thus no further magnification is 
required. 

Parameter for  
Compressive 
 Resistance, n 

 ≥ 0 Program 
Determined 

Parameter for Compression Resistance.  Unitless 
factor used in the calculation of compression re-
sistance.  Its value should be picked up for the com-
pression curve.  Typical values are 2.24 (SSRC 
Curve 1), 1.34 (SSRC Curve 2), and 1.00 (SSRC 
Curve 3).  Lower values are conservative.  Its effect 
is minimal if lambda is close to zero or very large 
(lambda > 2.0).  See CSA-S16-09 Section 13.3.1.  
Specifying 0 means the value is program determined. 

Yield Stress, Fy  ≥ 0 Program 
Determined 

Material yield strength used in the design/check.  
Specifying zero means the value is program deter-
mined. The program determined value is taken from 
the material property assigned to the frame object. 

Expected to speci-
fied Fy Ratio, Ry 

 ≥ 0 Program 
Determined 

The ratio of the expected yield strength to the mini-
mum specified yield strength. This ratio is used in 
capacity-based design for special seismic cases. 
Specifying zero means the value is program deter-
mined. 
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Table 3-2 Steel Frame Design Overwrites for "CSA S16-09" 
Item Possible Values Default Value Description 

Compressive  
Resistance, Cr 

 ≥ 0 Program 
Determined 

Allowable axial compressive capacity.  Specifying 
zero means the value is program determined. 

Tensile Resistance, 
Tr 

 ≥ 0 Program 
Determined 

Allowable axial tensile capacity. Specifying zero 
means the value is program determined. 

Major Bending 
Resistance, Mr3 

 ≥ 0 Program 
Determined 

Allowable bending moment capacity in major axis 
bending. Specifying zero means the value is program 
determined. 

Minor Bending 
Resistance, Mr2 

 ≥ 0 Program 
Determined 

Allowable bending moment capacity in minor axis 
bending. Specifying zero means the value is program 
determined. 

Major Shear  
Resistance, Vr2 

 ≥ 0 Program 
Determined 

Allowable shear capacity force for major direction 
shear. Specifying zero means the value is program 
determined. 

Minor Shear  
Resistance, Vr3 

 ≥ 0 Program 
Determined 

Allowable  shear capacity force for minor direction 
shear. Specifying zero means the value is program 
determined. 

Demand/Capacity 
Ratio Limit 

 ≥ 0 Program 
Determined 

The stress ratio limit to be used for acceptability. 
Stress ratios that are less than or equal to this value 
are considered acceptable. Program determined value 
means it is taken from the steel preferences. Specify-
ing 0 means the value is program determined. 

3.4 Design Loading Combinations 
The structure is to be designed so that its design strength equals or exceeds the 
effects of factored loads stipulated by the applicable design code. The default 
design combinations are the various combinations of the already defined analy-
sis cases, such as dead load (DL), live load (LL), wind load (WL), and horizon-
tal earthquake load (EL). 

For the CSA S16-09 code, the following default design combinations are gen-
erated by the program (CSA 7.2.2, NBCC Table 4.1.3.2.A): 

1.4 DL  (Case 1, NBCC Table 4.1.3.2.A) 
1.25 DL + 1.5 LL (Case 2, NBCC Table 4.1.3.2.A) 
1.25 DL + 1.5 LL ± 0.4 WL (Case 2, NBCC Table 4.1.3.2.A) 

1.25 DL ± 1.4 WL (Case 4, NBCC Table 4.1.3.2.A) 
0.9 DL ± 1.4 WL (Case 4, NBCC Table 4.1.3.2.A) 
1.25 DL  ± 1.4 WL + 0.5 LL (Case 4, NBCC Table 4.1.3.2.A) 
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1.0 DL ± 1.0 EL (Case 5, NBCC Table 4.1.3.2.A) 
1.0 DL ± 1.0 EL + 0.5 LL (Case 5, NBCC Table 4.1.3.2.A) 

The code is required to consider Notional Load in the design loading combina-
tions for steel frame design. The program allows the user to define and create 
notional loads as individual load cases from a specified percentage of a given 
gravity load acting in a particular lateral direction. These notional load cases 
should be considered in the combinations with appropriate factors, appropriate 
directions, and appropriate senses. Notional loads are automatically included in 
the default design load combinations that do not include lateral loads. Notional 
load patterns are only added to a load combination when their corresponding 
gravity load patterns are included in that combination, using the corresponding 
scale factor. For further information, refer to the "Notional Load Cases" section 
in Chapter 2. 

The combinations described herein are the default loading combinations only. 
They can be deleted or edited as required by the design code or engineer-of-
record. The program allows live load reduction factors to be applied to the 
member forces of the reducible live load case on a member-by-member basis 
to reduce the contribution of the live load to the factored responses. 

3.5 Classification of Sections for Local Buckling 
For the determination of the nominal strengths for axial compression and flex-
ure, the sections are classified as Class 1 (Plastic), Class 2 (Compact), Class 3 
(Noncompact), or Class 4 (Slender). The program classifies the individual sec-
tions in accordance with Table 3-3 (CSA 11.1, 11.2, 13.5.c, Table 2). As speci-
fied in that table, a section is classified as Class 1, Class 2, Class 3 or Class 4 
as applicable.  

For elements supported along only one edge parallel to the direction of com-
pression force, the width shall be taken as follows: 

(a) For flanges of I-shaped members and tees, the width bel is one-half the full 
nominal dimension, bf . 

 (b) For legs of angles and flanges of channels and zees, the width bel is the full 
nominal dimension. 
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(c) For plates, the width bel is the distance from the free edge to the first row of 
fasteners or line of welds. 

(d) For webs of hot rolled sections, h is the clear distance between flanges. 

Refer to Table 3-3 (CSA Table 1 and Table 2) for the graphic representation of 
element dimensions. 

Table 3-3 Maximum Width-to-Thickness Ratios  

Section 
Type 

Description 
of Element Example 

Width- 
Thickness  

Ratio 

Elements 
in Axial 

Compres-
sion  

Limiting Width-to-Thickness Ratios  
for Elements in Flexural Compression 

Class 1 
(Plastic) 

Class 2 
(Compact) 

Class 3 
(Non-

compact) 
Class 4 

(Slender) 
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≤

yF
 170

≤
yF

 200
≤

yF
 ≤ 60 

 

T 
Sh

ap
e 

Flanges of  
T-sections 

 

2elb t  
200

≤
yF

 145
≤

yF
 170

≤
yF

 200
≤

yF
 ≤ 60 

 

T 
Sh

ap
e 

 Stems of  
T-sections 

 
d t  

340
≤

yF
 --- --- 

340
≤

yF
 Any 

 
C

ha
nn

el
 

 

Flanges of 
Channels 

 

elb t  
200

≤
yF

 145
≤

yF
 170

≤
yF

 200
≤

yF
 ≤ 60 

 

D
ou

bl
e 

C
ha

nn
el

 

Flanges of 
Double  

Channels 
 

elb t  
200

≤
yF

 145
≤

yF
 170

≤
yF

 200
≤

yF
 ≤ 60 

 

A
ng

le
 

Legs of  
Angles 

 

elb t  
200

≤
yF

 --- --- 
200

≤
yF

 ≤ 60 
 

D
ou

bl
e 

A
ng

le
 

Legs of double 
angles 

 

elb t  
200

≤
yF

 --- --- 
200

≤
yF

 ≤ 60 
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Table 3-3 Maximum Width-to-Thickness Ratios  

Section 
Type 

Description 
of Element Example 

Width- 
Thickness  

Ratio 

Elements 
in Axial 

Compres-
sion  

Limiting Width-to-Thickness Ratios  
for Elements in Flexural Compression 

Class 1 
(Plastic) 

Class 2 
(Compact) 

Class 3 
(Non-

compact) 
Class 4 

(Slender) 

B
ox

 

Flexural or 
axial  

compression 
of flanges 

under major 
axis bending  

elb t  
670

≤
yF

 

420
≤

yF
(rolled) 

525
≤

yF
(welded) 

525
≤

yF
 670

≤
yF

 No limit 

 

Axial only 
compression 

 

D t  
23 000

≤
y

,
F

 13 000
≤

y

,
F

 18 000
≤

y

,
F

 66 000
≤

y

,
F

 No limit 

Round 
Bar ------ ------ ---- ---- Assumed Class 2 

Rectan-
gular ------ ------ ---- ---- Assumed Class 2 

General ------ ------ ---- ---- Assumed Class 3 
SD  

Section ------ ------ ---- ---- Assumed Class 3 

 

For elements supported along two edges parallel to the direction of the com-
pression force, the width shall be taken as follows: 

(a) For webs of rolled or formed sections, h is the clear distance between 
flanges less the fillet or corner radius at each flange; hc is twice the dis-
tance from the centroid to the inside face of the compression flange less the 
fillet or corner radius. 

(b) For webs of built-up sections, h is the distance between adjacent lines of 
fasteners or the clear distance between flanges when welds are used. 

(c) For flange or diaphragm plates in built-up sections, the width b is the dis-
tance between adjacent lines of fasteners or lines of welds. 

 (d) For flanges of rectangular hollow structural sections (HSS), the width b is 
the nominal outside dimension less four times the wall thickness. For webs 
of rectangular HSS, h is the nominal outside dimension less four times the 
wall thickness. The thickness, t, shall be taken as the design wall thickness. 
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Figure 3-1 CSA S16-09 Definition of Geometric Properties 
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In classifying web slenderness of I-Shapes, Box, Channel, Double Channel, 
and all other sections, it is assumed that there are no intermediate stiffeners. 
Double Angles and Channels are conservatively assumed to be separated. 
When slenderness parameters are larger than the limits for Class 4 sections, the 
section is classified as Too Slender. Stress check of Too Slender sections is 
beyond the scope of this program. 

3.6 Calculation of Factored Forces and Moments 
The factored member loads that are calculated for each load combination are 
Cf, Mf33, Mf22, Vf2, Vf3 and Tf corresponding to factored values of the axial com-
pression, the major and minor moments and shears, and axial tension, respec-
tively. These factored loads are calculated at each of the previously defined  
stations. 

3.7 Calculation of Factored Strengths 
The nominal resistance in compression, tension, bending, and shear are com-
puted for Plastic, Compact, Noncompact, and Slender members in accordance 
with the text in the following sections. The nominal flexural resistance for all 
shapes of sections are calculated based on their principal axes of bending. For 
the Rectangular, I-Shape, Box, Channel, Double Channel, Circular, Pipe, T-
Shape, and Double Angle sections, the principal axes coincide with their geo-
metric axes. For the Single Angle sections, the principal axes are determined 
and all computations except shear are based on that. 

For all sections, the nominal shear strengths are calculated for directions 
aligned with the geometric axes, which typically coincide with the principal 
axes. Again, the exception is the Single Angle section.   

If the user specifies nonzero nominal capacities for one or more of the 
members on the Steel Frame Overwrites form, those values will override 
the calculated values for those members. The specified capacities should 
be based on the principal axes of bending for flexure and on the geometric 
axes for shear. 

3 - 16 Calculation of Factored Forces and Moments 
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3.7.1 Factored Tensile Strength 
This section applies to the members subject to axial tension. 

The factored axial tensile strength value, Tr, is taken as φAgFy (CSA 13.2.(a)(i)). 
For members in tension, if L / r  is greater than 300, a message is printed  
accordingly (CSA 10.4.2.2). 

.r g yT A F= φ  (CSA 13.2(i)) 

.r e uT A F= φ  (CSA 13.2(ii)) 

The effective net area, Ae, is assumed to be equal to the gross cross-sectional 
area, Ag, by default. For members that are connected with welds or members 
with holes, the e gA A ratio must be modified using the steel frame design 
Overwrites to account for the effective area. 

3.7.2 Factored Compressive Strength 
Compression capacity is taken as the minimum of the two limit states: Flexural 
Buckling; and Torsional and Flexural-Torsional Buckling. 

For the Flexural Buckling limit state, the factored axial compressive strength 
value, Cr, for Class 1, 2, or 3 sections depends on a factor, λ, which eventually 
depends on the slenderness ratio, KL/r, which is the larger of (K33L 33 /r33) and 
(K22L 22 /r22), and is defined as 

 ,yFKl
r E

=λ
π

 

For single angles rz is used in place of r33 and r22. For members in compression, 
if KL/r is greater than 200, a message is printed (CSA 10.4.2).  

Then the factored axial strength is evaluated as follows (CSA 13.3.1): 

 
1

2(1 ) .n n
r yC AF

−
= φ + λ   (CSA 13.3.1) 
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where n is an exponent, and it takes three possible values to match the 
strengths related to three SSRC curves. The default n is 1.34, which is assigned 
to W-shapes rolled in Canada, fabricated Boxes and I-shapes, and cold-formed 
non-stress relieved (Class C) hollow structural sections (HSS) (CSA 13.3.1, 
CSA C13.3). The WWF sections produced in Canada from plates with flame-
cut edges and hot-formed or cold-relieved (Class H) HSS are assigned to a  
favorable value of 2.24 (CSA 13.3.1, CSA C13.3). For heavy sections, a small-
er value of n is considered appropriate (CSA C13.3). The program  
assumes the value of n as follows: 

 

2.24, for WWF, HS, and HSS (Class H) sections,
1.34 for W, L, and 2L sections and normal HS and HSS sections,
1.34 for other sections with thickness less than 25.4 mm, except WWF sections,
1.00, for other 

n =

sections with thickness larger than or equal to 25.4mm.







 

The HSS sections in the current Canadian Section Database of the program are 
prefixed as HS instead of HSS. Also, to consider any HSS section as Class H, 
it is expected that the user would put a suffix to the HS or HSS section names. 

The value of n can be overwritten in the steel design overwrites. 

For the Torsional or Torsional-Flexural Buckling limit state, the factored com-
pressive resistance, Cr,  for Class 1, 2, or 3 sections is computed using the fol-
lowing equation, with a value of n = 1.34: 

 
1

2(1 )n n
r yC AF

−
= φ + λ  (CSA 13.3.1) 

and the value of Fe is taken as: 

a) For doubly symmetric and axisymmetric sections, the least of Fex, Fey and 
Fez;  

b) For single symmetric sections, with the y axis taken as the axis of sym-
metry, the lesser of Fex and Feyz,  

where, 
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2

2 .ex

x x

x
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K L
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π
=
 
 
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 (CSA 13.3.2) 

2

2 .ey

y y

y
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K L
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π
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 
  
 

 (CSA 13.3.2) 
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2

2 2
1 .ez

oz z

ECwF GJ
K L Ar

 π = +
 
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 (CSA 13.3.2) 

( )2

4
1 1 .

2
ey ez ey ez

eyz

ey ez

F F F F
F

F F

 + Ω = − − Ω +  

 (CSA 13.3.2) 

Lz = Unbraced length factor for torsional buckling. 

Kz = The effective length factor for torsional buckling, conservatively tak-
en as 1.0. This can be overwritten in the design overwrites. 

2 2 2 2 2
o o o x yr x y r r= + + + , and 

2 2

21 o o

o

x y

r

 +
Ω = −  

  
, 

where xo, yo = the principal coordinates of the shear center to the centroid 
of the cross-section. 

c) For angle sections, Fe is taken as the smallest root of: 

( )( )( ) ( ) ( )
2 2

2 2 0o o
e ex e ey e ez e e ey e e ex

o o

x yF F F F F F F F F F F F
r r

   − − − − − − − =   
   

 

The factored compressive resistance, Cr, for  Class 4 sections ( CSA 11, Table 
1, Table 2) is calculated using the preceding procedure as described for Class 
1, 2, and 3 sections, with the exception that an effective area (CSA 13.3.3(a)) 
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or an effective yield stress (CSA 13.3.3(b)) is used. The choice of using the  
effective area or effective yield stress can be made in the preferences. The  
effective area is calculated using a reduced element width that meets the max-
imum width-to-thickness ratio of a Class 3 section (CSA 13.3.3(a)). The effec-
tive yield stress is determined from the width-to-thickness ratio that meets the 
Class 3 limit (CSA 13.3.3(b)). The factored axial compressive resistance, Cr, is 
calculated using the requirements of Clause 13.3.1 or 13.3.2 as applicable. The 
slenderness ratios are calculated using gross-section properties. 

The program uses the minimum of the factored axial compressive strength, Cr, 
computed from Cross-Sectional Strength, Overall Member Strength, and Tor-
sional and Lateral-Torsional Buckling Strength (CSA 13.8.2, 13.8.3). 

(a) Cross-Sectional Strength:  The axial compression capacity is based on 
the assumption that the number is fully braced in each direction (L22 = 0, 
L33 = 0), i.e., λ = 0. The axial compression capacity is based on the plas-
tic limit state. 

  Cr = φAFy (CSA 13.8.2(a), 13.8.3(a), 13.3.1) 

(b) Overall Member Strength:  The axial compression capacity is based on 
the assumption that K33 = 1 and K22 = 1. For biaxial bending, Cr is taken 
as the minimum axial capacity for the flexural buckling limit state for 

22 22

22

K L
r

 and 33 33

33
.K L

r
 However for uniaxial strong axis bending, it is 

based on the flexural buckling limit state for 22 22

22

K L
r

 (CSA 13.8.2(b), 

13.8.2(c), 13.3.1). 

(c) Lateral-Torsional Buckling Strength:  The axial compression capacity is 
based on the minimum of capacities from the flexural buckling limit state 
and the torsional and torsional-flexural buckling limit state (CSA 
13.8.2(c), 13.8.3(c), 13.3.1, 13.3.2). For the flexural buckling limit state, 
the compression capacity is based on both the major and minor direction 

buckling using both 22 22

22

K L
r

 and 33 33

33

K L
r

 with the appropriate values for 

K22 and K33. For the torsional and torsional-flexural buckling limit state, 

an additional slenderness parameter, 
min

,z zK L
r

 is used. 
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If the capacity Cr is overwritten, only the strength for the last case is modified, 
namely, the lateral torsional buckling strength. The capacity used for the cross-
sectional strength and the overall member strength case remain unaffected by 
this overwrite. 

3.7.3 Flexure Strength 
The factored moment resistance in the major and minor directions is based on 
the geometric shape of the section, the section classification for compactness, 
and the unbraced length of the member. The bending strengths are evaluated in 
accordance with CSA S16-09 as follows (CSA 13.5, 13.6). 

The program uses the minimum of the flexure strength, Mr, computed from 
Cross-Sectional Strength, Overall Member Strength, and Torsional and Lat-
eral-Torsional Buckling Strength (CSA 13.8.2, 13.8.3). 

Cross-Sectional Strength and Overall Member Strength:  The Mr33 and Mr22  are 
calculated assuming that the member is laterally fully supported (l22 = 0  and  
l33 = 0) irrespective of its actual lateral bracing length (CSA 13.5, 13.8.2(a), 
13.8.2(b), 13.8.3(a), 13.8.3(b)).  

Lateral-Torsional Buckling Strength: Mr33 and Mr22 are calculated based on  
actual unbraced length (CSA 13.6, 13.8.2(c), 13.8.3(c)). 

If the flexural capacities Mr33 and Mr22 are overwritten, only the strength for the 
last case is modified, namely, the lateral-torsional buckling strength. The ca-
pacities used for the cross-sectional strength and the overall member strength 
cases remain unaffected by the overwrites. 

For Cross-Sectional Strength and Overall Member Strength cases, the moment 
capacities are considered to be as follows: 

For Class 1 and 2 Sections: 

 r yM ZF= φ  = φMp (CSA 13.5)  

For Class 3 Sections: 

 r yM SF= φ  = φMy (CSA 13.5) 

For Class 4 Sections: 
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,eff

, when using effective section properties
, when using effective yield stress

e y
r

y

S F
M

SF
φ= φ

 

where (CSA 13.5) 

 Se  = the effective section modulus, and 

 Fy,eff  = the effective section yield stress. 

The factored flexural resistance, Mr, for Class 4 sections (CSA 11, Table 1,  
Table 2) is calculated using the effective section modulus (CSA 13.5.c(iii)) or 
using an effective yield stress (CSA 13.5). The choice of using the effective 
section modulus or effective yield stress can be made in the preferences. 

The effective section modulus is calculated using a reduced element width that 
meets the maximum width-to-thickness ratio of a Class 3 section (CSA 
13.5.c(iii)). The use of effective section modulus in determining the factored 
moment resistance should be limited to members with Class 4 flanges and 
Class 3 or more compact webs. If the section has a web of Class 4, even though 
the program uses the preceding simplistic equation, a more detailed procedure 
needs to be followed by the user (CSA 13.5.c(i), 13.5.c(ii)). The user should do 
those checks independently or should use the effective yield stress method. The 
effective yield stress, Fy,eff, is determined from the width-to-thickness ratio  that 
meets the Class 3 limit (CSA 13.5). The effective yield stress method can be 
used for both Class 4 flanges and Class 4 webs. The slenderness ratios are cal-
culated using gross section properties.  

For Lateral-Torsional Buckling Strength, the moment capacities are calculated 
using the procedure described in the following subsections (CSA 13.6, 
13.8.2(c), 13.8.3(c)).  

3.7.3.1 I-Shapes, Double Channels and Boxes 

3.7.3.1.1 Major Axis of Bending 
For Class 1 and 2 sections of I-Shapes, Double Channels, and Boxes bent about 
the major axis,  

when Mu > 0.67 Mp33, 
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Mr33 =  33
33 331.15 1 0.28 ,p

p p
u

M
M M

M
 

φ − ≤ φ 
 

    (CSA 13.6 (a)(i)) 

when    Mu ≤ 0.67 Mp33,  

 r33 uM = Mφ  (CSA 13.6 (a)(ii)) 

where, 

Mr33  =  Factored major bending resistance, 
Mp33 =  Major plastic moment = z22Fy, 
Mu   =  Critical elastic moment, 

2
2

22 22u w
EM EI GJ I C

L L
ω π π = +  

 
 (CISC 13.6 (a)) 

L   =  Laterally unbraced length, l22, 
Cw =  Warping constant assumed as zero for Boxes and 

max
2 2 2 2 2

max

4 2.5.
4 7 4a b c

M

M M M M
ω = ≤

+ + +
 (CSA 13.6 (a)) 

where, 

Mmax = maximum factored bending moment in unbraced segment 
Ma  = factored bending moment at one-quarter point of unbraced 

segment 
Mb  = factored bending moment at midpoint of unbraced segment 
Mc  = factored bending moment at three-quarter point of un-

braced segment 
 
The program defaults ω2 to 1.0 if the unbraced length, l, of the member is 
overwritten by the user (i.e., it is not equal to the length of the member). ω2 
should be taken as 1.0 for cantilevers. However, the program is unable to de-
tect when the member is a cantilever. The user can overwrite the value of ω2 
for any member by specifying it. 

For Class 3 and Class 4 sections of I-Shapes, Channels, and Boxes bent about 
the major axis,  
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when  330.67 ,u yM M>   

 33
33 33 331.15 1 0.28 ,y

r y y
u

M
M M M

M
 

= φ − ≤ φ 
 

  (CSA 13.6 (b)(i)) 

when  330.67 ,u yM M≤    

 33 ,r uM M= φ  (CSA 13.6 (b)(ii)) 

Mr33 and Mu are as defined earlier in this section, and My33 is the major yield 
moment. 

3.7.3.1.2 Minor Axis of Bending 
For Class 1 and 2 sections of I-Shapes and Double Channels bent about their 
minor axis, 

 22 22 22 .r p yM M Z F= φ = φ  (CSA 13.6 a) 

For Class 3 and Class 4 sections of I-Shapes and Double Channels bent about 
their minor axis, 

 22 22 22 .r y yM M S F= φ = φ  for Class 3 

 22 22 22, .r y e yM M S F= φ = φ  For Class 4 

For Class 1 and 2 sections of Boxes bent about the minor axis,  

when Mu > 0.67 Mp22, 

Mr22 =  22
22 221.15 1 0.28 ,p

p p
u

M
M M

M
 

φ − ≤ φ 
 

    (CSA 13.6 (a)(i)) 

when Mu ≤ 0.67 Mp22, 

 r22 uM = Mφ  (CSA 13.6 (a)(ii)) 

where, 
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Mr22  =  Factored major bending resistance, 
Mp22  =  Major plastic moment = z22Fy, 
Mu      =  Critical elastic moment. 

For Class 3 and Class 4 sections of Boxes bent about the minor axis,  

when  220.67 ,u yM M>   

 22
22 22 221.15 1 0.28 ,y

r y y
u

M
M M M

M
 

= φ − ≤ φ 
 

 (CSA 13.6 (b)(i)) 

when  220.67 ,u yM M≤   

 22 .r uM M= φ  (CSA 13.6 (b)(ii)) 

Mr22 and Mu are as defined earlier, and My22 is the minor yield moment. 

3.7.3.2 Rectangular Bar 

3.7.3.2.1 Major Axis of Bending 
For Class 2 sections of Rectangular bars bent about their major axis,  

when  330.67 ,u pM M>   

 33
33 33 331.15 1 0.28 ,p

r p p
u

M
M M M

M
 

= φ − ≤ φ 
 

  (CSA 13.6 (b)) 

when  330.67 ,u yM M≤  

 33 .r uM M= φ   (CSA 13.6 (b)) 

3.7.3.2.2 Minor Axis of Bending 
For Class 2 sections of Rectangular bars bent about their minor axis, 

when  220.67 ,u pM M>   
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 22
22 22 221.15 1 0.28 ,p

r p p
u

M
M M M

M
 

= φ − ≤ φ 
  

  (CSA 13.6 (b)) 

when  220.67 ,u yM M≤   

 22 .r uM M= φ   (CSA 13.6 (b)) 

3.7.3.3 Pipes and Circular Rods 
For pipes and circular rods bent about any axis, 

 33r yM Zf=φ  for Class 1 and 2   (CSA 13.5, 13.6 (c)) 

33r yM Sf=φ  for Class 3   (CSA 13.5, 13.6 (c)) 

33 er yM S f=φ  for Class 4 (CSA 13.5, 13.6 (c)) 

3.7.3.4 Channel Section 

3.7.3.4.1 Major Axis of Bending 
For Class 3 and 4 Channel sections bent about their major axis,  

when 330.67 ,u yM M>   

 33
33 33 331.15 1 0.28 ,y

r y y
u

M
M M M

M
 

= φ − ≤ φ 
 

  (CSA 13.6 (b)) 

when 330.67 ,u yM M≤  

 33 .r uM M= φ   (CSA13.6 (b)) 

3.7.3.4.2 Minor Axis of Bending 
For Class 3 and 4 Channel sections bent about their minor axis, 

  .r22 y22 22 yM = M = Z Fφ  
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3.7.3.5 T-Shapes and Double Angles 

3.7.3.5.1 Major Axis of Bending 
For T-Shape and Double Angle sections bent about their major axis,  

when 33,u yrM M>   

 ( )33 33 33 33 33 ,u
r p p yr P

yr u

L LM M M M M
L L

  −
= φ − − ≤ φ   −   

 (CSA 13.6 (e)) 

where, 

 33 min0.7 ,yr yM S F=  Smin is the smaller section modulus 

 yrL =Length L obtained by setting 33,u yrM M>  

 1.1 ,u t yL E F= γ  

 ,

12 1
3

c
t

c

c c

b

h w
b t

=
 
+ 

 

γ  

where, 

hc = depth of the web in compression 
bc = width of compression flange 
tc = thickness of compression flange 

 
when 33,u yrM M≤  

 33 .r uM M= φ   (CSA13.6 (e)) 

where, 
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2 2
23 33

2 2
3333

4
2

w
u x x

EI CGJLM
IL EI

  ω π  = β + β + +  π   
 (CISC 13.6 (e)) 

L   =  Laterally unbraced length, l22, 
Cw =  Warping constant, taken from section database 

( )
2

33

33 22

2
0.9 1 1yc

x
I Id t
I I

     β = − − −       
 

xβ  = asymmetry parameter for singly symmetric beams 

ycI  = moment of inertia of the compression flange about the y-axis 

ytI  = moment of inertia of the tension flange about the y-axis 

and when singly symmetric beams are in single curvature 

3 2ω = ω   for Double Angle Sections 

3 1.0ω =   for T-Sections 

3.7.3.5.2 Minor Axis of Bending 
For Class 3 and 4 sections of T-Shapes and Double Angles, the factored minor 
bending strength is assumed as, 

  .r22 y 22M =  F Sφ  

3.7.3.6 Angle Sections 
The factored flexural strength for lateral-torsional buckling limit state of Single 
Angle sections is conservatively calculated based on the principal axes of 
bending. 

The factored flexure strength for bending about the major principal axis for the 
limit state of lateral-torsional buckling, Mr33, is given as follows: 
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,

33

0.1792 , if  and

1.92 117 1.5 , if .

e
e e y

y

r
y

y y e y
e

M M M M
M

M
M

M M M M
M

 − ≤ 
 

= φ  − ≤ > 
 

 

 (CSA 13.6(f), AISC F10-2, F10-3) 

where Me is the elastic lateral-torsional buckling moment defined as follows: 

2 2

2
2

2

0.46 for equal-leg angles,

4.9 0.052 for unequal-leg angles.

b

e
z b

w w
z

Eb r C
L

M
EI C Lt

rL





=      β + +β     

 

 (CSA 13.6(f), AISC F10-5.6) 

where, 

 Cb = Lateral-torsional buckling modification factor for non-uniform 
moment diagram. It is computed using equation AISC F1-1.  
A limit on Cb is imposed (Cb ≤ 1.5) in the program (AISC 
F10). 

 L = Laterally unbraced length of the member. It is taken as the max 
(L22, L33) in the program because L22 and L33 are not defined in 
the principal direction, in (mm). 

 I2 = Minor principal axis moment of inertia, mm4. 

 rt = Radius of gyration for the minor principal axis, mm. 

 t = Angle leg thickness, mm. It is taken as min(tw, tf). 

 βw = A section property for unequal-legged angles. It is given as fol-
lows: 

( )2 2
0

1 2w
w A

z w z dA z
I

β = + −∫  (AISC Table C-F10.1) 
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βw is positive for short legs in compression, negative for  long 
legs in compression, and zero for equal-leg angles. If the long 
leg is in compression anywhere along the unbraced length of 
the member, the negative value of βw should be used (AISC 
F10.2). It is conservatively taken as negative for unequal-leg 
angles. 

z = coordinate along the minor principal axis 

w = coordinate along the major principal axis 

z0 = coordinate of the shear center along the z-axis with re-
spect to the centroid 

Iw = major principal axis moment of inertia 

Iz = minor principal axis moment of inertia 

In the earlier equation, My is taken as the yield moment about the major princi-
pal axis of bending, considering the possibility of yielding at the heel and both 
of the leg tips. 

The factored flexural strength for bending about the minor principal axis for 
the limit state of lateral-torsional buckling, Mr22, is taken as follows: 

 Mr22 = φz22Fy ≤ 1.5 φS22Fy (CSA 13.6(f), AISC F10-2) 

3.7.3.7 General Sections 
For General sections, the factored major and minor direction bending strengths 
are assumed as, 

    33 33 ,r yM F S= φ  and 

22 22.r yM F S= φ  

3.7.4 Shear Strength 
The factored shear strengths are calculated for shears along the geometric axes 
for all sections. For I-Shape, Box, Channel, Double Channel, T-Shape, Double 
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Angle, Pipe, Circular, and Rectangular sections, the principal axes coincide 
with their geometric axes. For Angle sections, principal axes do not coincide 
with their geometric axes. 

In calculating factored strength for shear, Vr, it is assumed that there is no in-
termedial stiffness used to enhance shear strength of a section (CSA 13.4.1.1). 

3.7.4.1 Shear in the Major Direction 
The factored shear strength, Vr2, for major direction shears in I-Shapes, Boxes, 
Channels, Double-Channels, and T-Shapes is calculated as follows: 

 Vr2 = φAwFs (CSA 13.4.1.1) 

where Aw is the design shear area. It is taken as follows: 

 

for I-Shape sections,
for Channel sections,
for T-Shape sections,

2 for Double Channel sections, and
2 for Box sections.

w

dw
dw

A dw
dw
hw

=









 (CSA 13.4.1.1) 

Fs is the ultimate stress. It is taken as follows: 

For unstiffened webs: 

when 1014

y

h
w F
≤  

 Fs = 0.66Fy (CSA 13.4.1.1(a),(i)) 

when 1014 1435

y y

h
wF F

< ≤  

 
( )

670 y
s

F
F

h w
=  (CSA 13.4.1.1(a),(ii)) 
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when 1435

y

h
w F
>  

 
( )2
961200

sF
h w

=  (CSA 13.4.1.1(a),(iii)) 

The factored shear strength, Vr2, for major direction shears in Double Angle, 
Angle, Rectangular, Circular, Pipe, and General sections is calculated as fol-
lows: 

 Vr2 = φAwFs (CSA 13.4.1.1) 

where 

 Fs = 0.66Fy (CSA 13.4.2) 

3.7.4.2 Shear in the Minor Direction 
The factored shear strength, Vr3, for minor direction shear in I-Shapes, Boxes, 
Channels, Double Channels, and T-Shapes is calculated as follows: 

 Vr3 = φAwFs (CSA 13.4.1.1) 

where, Aw is taken as follows: 

 

2 for I-Shape sections,
2 for Channel sections,

for T-Shape sections,
4 for Double Channel sections, and
2 for Box sections.

f f

f f

w f f

f f

f f

b t
b t

A b t
b t
b t




= 





 

Fs is calculated in the same way as that for major direction shear, except that 
h w  is taken as follows: 
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( )2 for I-Shape sections,

for Channel sections,
for T-Shape sections,

2 for Double Channel sections, and
for Box sections.

f f

f f

f f

f f

f f

b t

b t
h w b t

b t
b t




= 





 

The factored shear strength, Vr3, for minor direction shears in Double Angle, 
Angle, Rectangular, Circular, Pipe, and General sections is calculated as fol-
lows: 

 Vr3 = φAwFs (CSA 13.4.1.1) 

where, 

 Fs = 0.66Fy. (CSA 13.4.2) 

3.8 Design of Members for Combined Forces 
Previous sections of this design manual address members subject to only one 
type of force, namely axial tension, axial compression, flexure, or shear. This 
section addresses the design of members subject to a combination of two or 
more of the individual forces. 

In the calculation of the demand/capacity (D/C) ratios, first, for each station 
along the length of the member, the actual member force/moment components 
are calculated for each design combination. Then, the corresponding capacities 
are calculated. Then, the D/C ratios are calculated at each station for each 
member under the influence of each of the design combinations. The control-
ling D/C ratio is then obtained, along with the associated station and design 
combination. A D/C ratio greater than the D/C ratio limit (whose default value 
is 1.0) indicates exceeding a limit state. 

During the design, the effect of the presence of bolts or welds is not consid-
ered. 
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3.8.1 Axial and Bending Stresses 
From the factored axial loads and bending moments at each station and the fac-
tored strengths for axial tension and compression and major and minor axis 
bending, a D/C ratio is produced for each of the load combinations as follows:  

3.8.1.1 Axial Compressive and Bending — Class 1 and Class 2 I-Shapes 
If the axial load is compressive, the D/C ratio for Class 1 and Class 2 sections 
of I-Shaped members is given by: 

13 33 12 22

33 22
0.85f f f

r r r

C U M U M
C M M

+ +β  (CSA 13.8.2) 

where, 

Cf is the factored axial compressive loading, including P-∆ effects as de-
fined in CSA clause 8.4, 

Mf33 and Mf22 are the factored major and minor axis bending moment, in-
cluding P-∆ effects as described in CSA clause 8.4. 

Cr is the factored axial compression capacity for different limit states 
(CSA 13.3) 

Mr33 and Mr22 are the factored major and minor axis flexural capacity for 
different limit states (CSA 13.5, 13.6), 

β is a coefficient, and 

U12 and U13 are two factors to account for the second-order effects due to 
the deformation of a member between its ends. They are different for 
different limit states. 

β is taken as follows: 

 β  = 0.6 + 0.4 λy ≤ 0.85 (CSA 13.8.2) 

where, 
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 22
2

22

y
y

FKL
r E

λ
π

=  (CSA 13.3.1) 

U1 is taken as follows: 

 1
1 ,

1 f

e

U c
c

ω
=

−
 where, (CSA 13.8.4) 

2

2 .e
EIc

L
π

=   (CSA 13.8.4) 

The factor U1 must be a positive number. Therefore, cf must be less than 
ce. If this in not true, a failure condition is declared. 

If the factor U12 or U13 is overwritten by the user, the calculated value is 
replaced with the user value. 

ω1 is the coefficient related to the distribution of moment over the span 
within the braced segment. 

(i) For beam-columns not subject to transverse loading between sup-
ports in the plane of bending, 

  ( )1 0.6 0.4 0.4a bM Mω = − ≥  (CSA 13.8.5(a)) 

where Ma and Mb, calculated from the analysis, are the smaller and 
larger moments, respectively, at the ends of that portion of the 
member unbraced in the plane of bending under consideration.  
Ma /Mb is positive when the member is bent in reverse curvature, 
negative when bent in single curvature. 

(ii) For beam-columns subjected to distributed transverse loading be-
tween supports, the value of ω1 is taken as 1.0. 

(iii) For beam-columns subjected to a single concentrated transverse 
loading between supports, the value of ω1 is taken as 0.85. 

 When Mb is zero, ω1 is taken as 1.0, the program defaults ω1 to 1.0, if the 
unbraced length is more than the actual member length. The user can 
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overwrite the value of ω1 for any member. ω1 can be expressed as fol-
lows: 

 1

1.00, if length is more than actual length,
1.00, if tension member,
1.00, if both ends unrestrained

0.6 0.4 , if no transverse loading,

1.00, if transverse loading is present, and
0.85, if single concentr

a

b

M
M

ω =
−

ated load is present.













 (CSA 13.8.5) 

The program checks the interaction equation (CSA 13.8.2) for three different 
limit states:  (a) Cross-Sectional Strength; (b) Overall Member Strength; and 
(c) Lateral-Torsional Buckling Strength. In each case, β1, U13, U12, Cr, Mr33, 
and Mr22 may assume different values. 

(a)  Cross-Section Strength (CSA 13.8.2(a)) 

 The axial compression capacity is based on the assumption that the 
member is fully braced in each direction (L22 = 0, L33 = 0), i.e., λ = 0. 
The axial compression capacity is based on plastic limit state. 

 Cr = φAFy (CSA 13.8.2(a), 13.3.1) 

If the axial capacity Cr is overwritten by the user, it is assumed to not 
apply to this limit state and so is ignored. 

 The Mr33 and Mr22 are calculated assuming that the members are fully 
supported (L22 = 0, L33 = 0, Lz = 0) irrespective of their actual lateral 
lengths. The moment capacities are given by CSA Clause 13.5 (CSA 
13.8.2(a), 13.5). 

If the capacities (Mr33 and Mr22) are overwritten by the user, they are 
assumed to not apply for this limit state and so are ignored. 

 U12 and U13 are calculated following the procedure described previ-
ously (CSA 13.8.4), but are taken to be not less than 1. 

 U12 ≥ 1.0 (CSA 13.8.2(b), 13.8.4) 
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 U13 ≥ 1.0 (CSA 13.8.2(a), 13.8.4) 

 The β factor is taken as 0.6 

 β = 0.6 (CSA 13.8.2(a)) 

(b) Overall Member Strength (CSA 13.8.2(b)) 

 The axial compression capacity is based on the assumption that  
K33 = 1 and K22 = 1. For biaxial bending, Cr is taken as the minimum 

axial capacity for the flexural buckling limit state for 22 22

22
,K L

r
 and 

33 33

33
.K L

r
 However for uniaxial strong axis bending, it is based on the 

flexural buckling limit state for 22 22

22
.K L

r
 (CSA 13.8.2(5), 13.3.1) 

If the axial capacity Cr is overwritten by the user, it is assumed to not 
apply in this limit state and so is ignored. 

 Mr33 and Mr22 are calculated assuming that the members are fully 
supported (L22 = 0, L33 = 0, Lz = 0) irrespective of their actual lateral 
lengths. The moment capacities are given by CSA Clause 13.5 (CSA 
13.8.2(a), 13.6). 

If the capacities (Mr33 and Mr22) are overwritten by the user, they are 
assumed to not apply for this limit state and so are ignored. 

 U12 and U13 for members of braced frames are calculated following 
the procedure described previously (CSA 13.8.4). But for members 
of unbraced frames, they are taken as 1.0 (CSA 13.8.2(b), 13.8.4). 

 The β factor is calculated following the procedure described previ-
ously (CSA 13.8.2). 

(c) Lateral-Torsional Buckling Strength (CSA 13.8.2(c)) 

 The axial compression capacity is taken as the minimum axial com-
pression capacity considering flexural buckling (CSA 13.3.1) and 
torsional or lateral-torsional buckling (CSA 13.3.2). For the flexural 
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buckling limit state, the compression capacity is based on both the 

major and minor direction buckling using both 22 22

22

K L
r

 and 33 33

33

K L
r

 

with the actual values of K22 and K33. For the torsional and lateral-
torsional buckling limit state, additional slenderness parameter 

min

z zK L
r

 is used.  

If the axial capacity Cr is overwritten by the user, the overwritten 
value affects the Cr for this limit state. 

 Mr33 is calculated using the appropriate values of L22, L33, Lz, K22, K33 

and Kz (CSA 13.8.2(c), 13.5, 13.6). 

If the capacity Mr33 is overwritten by the user, the overwritten value 
affects the Mr33 for this limit state. 

 Mr22 is calculated assuming that the members are fully laterally sup-
ported (L22 = 0, L33 = 0, Lz = 0) irrespective of its actual lateral brac-
ing length. The moment capacities are given by CSA Clause 13.5 
(CSA 13.8.2(c), 13.5). 

If the capacity Mr22 is overwritten by the user, it is assumed to not 
apply for this limit state and so is ignored. 

 U12 and U13 are taken as 1 for unbraced frames (CSA 13.8.2(c)). 

 U13 = 1 (for unbraced frame) (CSA 13.8.2(c)) 

 U12 = 1 (for unbraced frame) (CSA 13.8.2(c)) 

U12 for members of braced frames is taken as the calculated value 
following the procedure described previously (CSA 13.8.4). 

U13 for members of braced frames is taken as the calculated value 
following the procedure described previously (CSA 13.8.4), except it 
is taken to be not less than 1 (CSA 13.8.2(c)). 

 U13 ≥ 1.0  (CSA 13.8.2(c), 13.8.4) 
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In addition to the preceding interaction equation, for Class 1 and 
Class 2 I-Shaped members, the following D/C ratio also is checked. 

 33 22

33 22

f f

r r

M M
M M

+  

where, 

Mf33 and Mf22 are the factored major and minor axes bending 
moments, including P-∆ effect as described in CSA Clause 8.7, 
and 

Mr33 and Mr22 are the factored major and minor axes flexural ca-
pacities considering both Clauses CSA 13.5 and 13.6, as appro-
priate. 

3.8.1.2 Axial Compression and Bending — Other Sections 
If the axial load is compressive, for all classes of sections except Class 1 and 
Class 2 I-Shaped sections, the D/C ratio is given by:  

 13 33 12 22

33 22

f f f

r r r

C U M U M
C M M

+ +  (CSA 13.8.3) 

where, 

Cf is the factored axial compressive loading, including P-∆ effect as  
defined in CSA Clause 8.7, 

Mf33 and Mf22 are the factored major and minor axis bending moment,  
including P-∆ effect as described in CSA Clause 8.7. 

Cr is the factored axial compression capacity for different limit states 
(CAS 13.3) 

Mr33 and Mr22 are the factored major and minor axis flexural capacity for 
different limit states (CSA 13.5, 13.6), 

U12 and U13 are two factors to account for the second-order effects due to 
the deformation of a member between its ends. They are different for 
different limit states. 
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The program checks the interaction equation (CSA 13.8.3) for the three differ-
ent limit states:  (a) Cross-Sectional Strength; (b) Overall Member Strength; 
and (c) Lateral-Torsional Buckling Strength. In each case, U13, U12, Cr, Mr33, 
and Mr22 may assume different values. The three limit states are handled in the 
same manner as those handled for the Class 1 and Class 2 I-Shaped sections. 
Please read the previous section for the appropriate values of U13, U12, Cr, Mr33, 
and Mr22 for all three limit states (CSA 13.8.3(a), 13.8.3(b), 13.8.3(c)). 

3.8.2 Axial Tension and Bending 
If the axial load is tensile, the D/C ratio is given by the larger of two ratios. In 
the first case, the ratio is calculated as  

33 22

33 22
,f f f

r r r

T M M
T M M

   
+ +   

   
  (CSA 13.9 (a)) 

assuming Mr22 and Mr33 are calculated based on a fully supported member (L22 

= 0  and L33 = 0).  If the capacities (Tr, Mr22, and Mr33) are overwritten by the 
user, the only overwritten capacity used in this case is Tr.. Mr22 and Mr33 over-
writes are assumed to not apply to this case and are ignored. 

In the second case, the ratio is calculated as 

33 22 33

33 22 33

f f f

r r r

M M T Z
M M M A

   
+ −   

   
  (for Class 1 and 2 Sections) (CISC 13.9 (b)) 

33 22 33

33 22 33

f f f

r r r

M M T S
M M M A

   
+ −   

   
  (for Class 3 and 4 Sections) (CISC 13.9 (b)) 

If the capacities (Mr22 and Mr33) are overwritten by the user, both of these 
overwritten capacities are used in this case. 

For Circular and Pipe sections, an SRSS combination is first made of the two 
bending components before adding the axial load component instead of the 
simple algebraic addition implied by the preceding interaction formulas. 
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3.8.3 Shear Stresses 
From the factored shear force values and the factored shear strength values at 
each station, for each of the load combinations, D/C ratios for shear in major 
and minor directions are produced as follows:  
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Chapter 4 
Special Seismic Provisions 

This chapter provides a detailed description of the algorithms related to seismic 
provisions in the design/check of structures in accordance with the “CSA 
S1609, Design of Steel Structure” (CSA 2009). The loading based on “NBCC 
2005” has been described in a separate document entitled “CSI Lateral Load 
Manual” (NBCC 2010; CSI 2012).  

For referring to pertinent sections of the corresponding code, a unique prefix is 
assigned for each code. 

• Reference to the CSA S16-09 code is identified with the prefix “CSA.” 

• Reference to the NBCC 2010 code is identified with the prefix “NBCC.” 

4.1 Design Preferences 
The steel frame design Preferences are basic assignments that apply to all of 
the steel frame members. The Preferences have been described previously in 
the relevant section of Chapter 3. Table 3-1 lists the steel frame design Prefer-
ences. The following steel frame design Preferences are relevant to the special 
seismic provisions. 

 Framing Type 
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 Ductility Related Modification Factor, Rd 

 Overstrength Related Modification Factor, Ro 

 Spectral Acceleration Ratio, IeFaSa(0.2) 

 Ignore Seismic Code? 

 Ignore Special Seismic Load? 

 Is Doubler Plate Plug Welded? 

4.2 Overwrites 
The steel frame design Overwrites are basic assignments that apply only to 
those elements to which they are assigned. The overwrites have been described 
previously in the relevant section of Chapter 3. Table 3-2 lists the steel frame 
design Overwrites. The following steel frame design overwrites are relevant to 
the special seismic provisions. 

 Frame Type 

4.3 Supported Framing Types 
The code now recognizes the types of framing systems identified in the table 
on the following page (CSA 27.2 to 27.10). With regard to those framing types, 
the program has implemented specifications for all of the types of framing sys-
tems listed. 

By default in the program, the frame type is taken as Limited-Ductile Moment-
Resisting Frame (Type LD MRF). However, the default frame type can be 
changed in the Preferences for all frames or in the Overwrites on a member-by-
member basis (Chapter 3). If a frame type Preference is revised in an existing 
model, the revised frame type does not apply to frames that have already been 
assigned a frame type through the Overwrites; the revised Preference applies 
only to new frame members added to the model after the Preference change 
and to the old frame members that were not assigned a frame type though the 
Overwrites.  
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Framing Type References 

Type D MRF (Ductile Moment-Resisting Frame) CSA 27.2 

Type MD MRF (Moderately Ductile Moment-Resisting Frame) CSA  27.3 

Type LD MRF (Limited-Ductility Moment-Resisting Frame) CSA  27.4 

Type MD CBF(TC) (Moderately Ductile Concentrically Braced Frame – Tension-Compression) CSA 27.5.2.3 

Type MD CBF(V) (Moderately Ductile Concentrically Braced Frame – Chevron) CSA 27.5.2.4 

Type MD CBF(TO) (Moderately Ductile Concentrically Braced Frame – Tension only) CSA 27.5.2.5 

Type MD CBF(OT) (Moderately Ductile Concentrically Braced Frame – Others) CSA 27.5.3.2 

Type LD CBF(TC) (Limited-Ductility Concentrically Braced Frame – Tension-Compression) CSA 27.6.2.1 

Type LD CBF(V) (Limited-Ductility Concentrically Braced Frame – Chevron) CSA 27.6.2.2 

Type LD CBF(TO) (Limited-Ductility Concentrically Braced Frame – Tension only) CSA 27.6.2.3 

Type LD CBF(OT) (Limited-Ductility Concentrically Braced Frame – Others) CSA 27.6.3 

EBF (Ductile Eccentrically Braced Frame) CSA 27.7 

Conventional MF CSA 27.11.1 

Conventional BF CSA 27.11.1 

Cantilever Column CSA 27.11.2 

4.4 Member Design 
This section describes the special requirements for designing a member. The 
section has been divided into subsections for each framing type. 

4.4.1 Type (Ductile) Moment-Resisting Frames (D MRF) 
For this framing system (Rd = 5.0, Ro = 1.5), the following additional require-
ments are checked or reported (CSA 27.2).  

 All beams are required to be Class 1 sections (CSA 27.2.2.1(a)).  

All beams are required to be laterally braced in accordance with the require-
ments of CSA 13.7(b) (CSA 27.2.2.1(b)). 
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17250 15500z

y

L
r F

+ κ
≤   (CSA 13.7(b), 27.2.2.1(b)) 

The value of κ is computed from the bending moment distribution for com-
bined gravity and seismic loads. 

If any of these criteria are not satisfied, the program issues an error message. 

 All columns are required to be Class 1 or Class 2 (CSA 27.2.3.1(a). 

All columns are required to be laterally braced in accordance with the re-
quirements of CSA Clause 13.7(b) (CSA 27.2.3.1(b)). 

 22

22

17250 15500

y

L
r F

+ κ
≤   (CSA 13.7(b), 27.2.3.1(b)) 

using κ = 0 (CSA 27.2.3.1(b)). 

The factored axial load shall not exceed 0.3φAFy when the specified one-
second spectral acceleration ratio (IE, Fv, Sa (1.0)) is greater than 0.30. 

If any of these criteria are not satisfied, the program issues an error message. 

 Columns need to be designed to resist gravity loads together with the forces 
induced by plastic hinging of the beams at each beam-to-column intersection: 

 ' 1.1
2
c

rc y pb h
dM R M V x

  ≥ + +  
  

∑ ∑   (CSA 27.2.3.2) 

where 

'
rcM∑ = sum of the column factored flexural resistance at the intersec-

tion of the beam and column centerlines. 

' 1.18 1 f
rc pc pc

y

C
M M M

C
 

= φ − ≤ φ  φ 
∑  (CSA 27.2.3.2) 

pcM  = nominal plastic moment resistance of the column 

fC   = results from summation of Vh acting at this level and above 
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pbM  = nominal plastic moment resistance of the beam 
x       = distance from the center of a beam plastic hinge to the column 

face 

The program calculates only the beam-column capacity ratio. The program 
does not design the column for this load yet. 

4.4.2 Type (Moderately Ductile) Moment-Resisting Frames (MD MRF) 
For this framing system (Rd = 3.5, Ro = 1.5), the following additional require-
ments are checked or reported (CSA 27.3).  

 All beams are required to be Class 1 or Class 2 sections (CSA 27.3(a)(1)). 

All beams need to be designed to be laterally braces in accordance with the 
requirements of CSA 13.7(a) (CSA 27.3, 27.2.2.1).  

 25000 15000cr

y y

L
r F

+ κ
=   (CSA 13.7(a), 27.3(a)(ii), 27.2.2(a)) 

The value of κ is computed from the bending moment distribution for com-
bined gravity and seismic loads (CSA 27.3(a)).  

If any of these criteria are not satisfied, the program issues an error message. 

 All columns are required to be Class 1 or  Class 2 sections (CSA 27.3, 27.2.3.1). 

All columns need to be designed to be laterally braced in accordance with the 
requirements of CSA Clause 13.7(b) (CSA 27.3, 27.2.3.1(b)). 

 17250 15500cr

y y

L
r F

+ κ
=   (CSA 13.7(a), 27.3(a)(ii), 27.2.2(a)) 

using κ = 0.0.  

The factored axial loads shall not exceed 0.5φAFy when the specified one-
second spectral acceleration ratio (IEFVSa(1.0)) is greater than 0.5 (CSA 
27.3(b), 27.2.3.1(b)).  

If any of these criteria are not satisfied, the program issues an error message. 
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 Columns need to be designed to resist gravity load together with the forces 
induced by plastic hinging of the beams at each beam-to-column intersection. 

 ' 1.1
2
c

rc y pb h
dM R M V x

  ≥ + +  
  

∑ ∑   (CSA 27.2.3.2, 27.3) 

where 

'
rcM∑ = sum of the column factored flexural resistance at the intersec-

tion of the beam and column centerlines. 

' 1.18 1 f
rc pc pc

y

C
M M M

C
 

= φ − ≤ φ  φ 
∑  (CSA 27.2.3.2) 

pcM  = nominal plastic moment resistance of the column 

fC   = results from summation of Vh acting at this level and above 

pbM  = nominal plastic moment resistance of the beam 
x  = distance from the center of a beam plastic hinge to the column 

face 

The program calculates only the beam-column capacity ratio. The program 
does not design the column for this load yet. 

4.4.3 Type (Limited-Ductility) Moment-Resisting Frames (LD MRF) 
For this framing system (Rd = 2.0, Ro = 1.3), the following additional require-
ments are checked or reported (CSA 27.4).  

 All beams are required to be Class 1 or Class 2 sections. If this criterion is 
not satisfied, the program issues an error message (CSA 27.4.2.1). 

 All columns are required to be Class 1 (CSA 27.4.2.1) I-Shaped sections 
(CSA 27.4.4.3).  

 When the specified short-period spectral acceleration ratio (IEFVSa(0.2)) is 
greater than 0.55 or the building height is greater than 60 m (CSA 27.4.2.2), 
columns shall satisfy the requirements of CSA 27.2.3.2 with modification of 
the term 1.1RyMpb to Mpb (CSA 27.4.2.2).  
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 '

2
c

rc pb h
dM M V x

  ≥ + +  
  

∑ ∑   (CSA 27.4.2.2) 

where, 

'
rcM∑ = sum of the column factored flexural resistance at the intersec-

tion of the beam and column centerlines. 

' 1.18 1 f
rc pc pc

y

C
M M M

C
 

= φ − ≤ φ  φ 
∑  (CSA 27.2.3.2) 

pcM  = nominal plastic moment resistance of the column 

fC   = results from summation of Vh acting at this level and above 

pbM  = nominal plastic moment resistance of the beam 
x = distance from the center of a beam plastic hinge to the column 

face 

If this criterion is not satisfied, the program issues an error message. 

4.4.4 Type (Moderately Ductile) Concentrically Braced Frames (MD 
CBF) 
For this framing system (Rd = 3.0, Ro = 1.3), the following additional require-
ments are checked or reported (CSA 27.5).  

Moderately ductile concentrically braced frames include the following (CSA 
27.5.2.1): 

(a) tension-compression bracing system (TC) 
(b) chevron braced system (V) 
(c) tension only bracing system (TO) 
(d) systems other than those in items (a), (b), and (c) (OT). 

 The slenderness ratio, KL/r, of diagonal bracing members shall not exceed 
2.0 (CSA 27.5.3.1).  

 For buildings with specified short-period spectral acceleration, IeFuSa(0.2),  
equal to or greater than 0.35, the width-to-thickness ratio of the flanges of  
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diagonal bracing members shall not exceed the following limits (CSA 
27.5.3.2).  

(a) when KL/r ≤ 100, 

(i)  for rectangular and square HSS: 330 ;yF  for circular HSS: 

10000 ;yF  

(ii)  for legs of angles and flanges of channels: 145 ;yF  
(iii)  for other elements: Class 1; 

(b) when KL/r = 200 

(i)  for HSS members: Class 1; 
(ii)  for legs of angles: 170 ;yF  
(iii)  for other elements: Class 2; and 

(c) when 100 < KL/r < 200, linear interpolation is used.  

When IEFaSa(0.2) is less than 0.35, sections shall be Class 1 or 2, with 
the exception of HSS, which shall be Class 1. The width-to-thickness ra-
tio for legs of angles shall not exceed 170 yF  (CSA 27.5.3.2). 

In all of the preceding cases, for back-to-back legs of double angle bracing 
members for which buckling out of the plane of symmetry governs, the 
width-to-thickness ratio shall not exceed 200 .yF   

 Columns in braced bays shall be Class 1 or Class 2 sections (CSA 27.5.5.2) 
and shall have a bending resistance of not less than 0.2 ZFy in combination 
with the computed axial loads (CSA 27.5.5.2). If any of these criteria are not 
satisfied, the program issues an error message.  

 Columns shall never have a slender section (CSA 27.5.5.2).  

4.4.4.1 Tension-Compression (TC) 
 Tension-compression concentrically braced system shall not exceed 40 m in 

height, except when the specified short-period spectral acceleration is less 
than 0.35 (CSA 27.5.2.3). The factored seismic force is increased by 3% per 
meter of height above 32 m when the building height exceeds 32 m. This 
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clause has not been implemented in the program yet. The user is required to 
check this clause independently. 

4.4.4.2 Chevron(V) 
 Chevron concentrically braced system shall not exceed 40 m in height, ex-

cept when the specified short-period spectral acceleration is less than 0.35 
(CSA 27.5.2.4). The factored seismic force is increased by 3% per meter of 
height above 32 m when the building height exceeds 32 m. This clause has 
not been implemented in the program yet. The user is required to check this 
clause independently. 

 The beams to which chevron bracing is attached shall be continuous and 
shall resist bending moments due to gravity loads (assuming no vertical sup-
port is provided by the bracing members), in conjunction with bending mo-
ments and axial forces induced by forces of AgRyFy and 0.2 AgRyFy in the ten-
sion and compression bracing members, respectively (CSA 27.5.2.4). 

While calculating the bending moment, if the braces are connected to the 
beam from above, the brace compression force shall be taken as 1.2 times the 
probable compressive resistance of the bracing member (CSA 27.5.2.4).  

In the case of buildings up to four stories, the tension brace force may be tak-
en as 0.6 AgRyFy, provided that the beam is a Class 1 section (CSA 27.5.2.4).  

4.4.4.3 Tension-Only (TO) 
 Tension-only concentrically braced systems shall not exceed 20 m in height. 

The factored seismic force is increased by 3% per meter of height above 16 
m when the building height exceeds 16 m (CSA 27.5.2.5(a)). This clause has 
not been implemented in the program yet. The user is required to check this 
clause independently. 

4.4.5 Type (Limited-Ductility) Concentrically Braced Frames (LD CBF) 
For this framing system (Rd = 2.0, Ro = 1.3), the following additional require-
ments are checked or reported (CSA 27.6).  
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Limited ductility concentrically braced frames include the following (CSA 
27.6.2.1 to 27.6.2.3): 

(a) tension-compression bracing system (TC) 
(b) chevron braced system (V) 
(c) tension only bracing system (TO) 
(d) systems other than those in items (a), (b), and (c) (OT). 

 For buildings with specified short-period spectral acceleration equal to or 
greater than 0.45, the width-to-thickness ratio of flanges of diagonal bracing 
members shall not exceed the following limits (CSA 27.5.3.2, 27.6.1).  

(a) when KL/r ≤ 100, 

(i) for rectangular and square HSS: 330 ;yF  for circular HSS: 

10000 ;yF  

(ii) for legs of angles and flanges of channels: 145 ;yF  
(iii) for other elements: Class 1; 

(b) when KL/r = 200, 

(i) for HSS members: Class 1; 
(ii) for legs of angles: 170 ;yF  
(iii) for other elements: Class 2; and 

(c) when 100 < KL/r < 200, linear interpolation is used.  

(d) when KL/r > 200 as permitted in clause 27.6.3.1, width-to-thickness lim-
its do not apply (CSA 27.6.3.2(a)). 

When IzFaSa (0.2) is less than 0.45, sections shall be Class 1 or Class 2. 
The width-to-thickness ratio for legs of angles shall not exceed 170 yF  
(CSA 27.5.3.2, 27.6.1). 

In all of the preceding cases, for back-to-back legs of double angle bracing 
members for which buckling out of the plane of symmetry governs, the 
width-to-thickness ratio shall not exceed 200 .yF   

 Columns in braced bays shall be Class 1 or Class 2 sections (CSA 27.5.5.2) 
and shall have a bending resistance of not less than 0.2 ZFy in combination 
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with the computed axial loads (CSA 27.5.5.2). If these criteria are not satis-
fied, the program issues an error message. 

4.4.5.1 Tension-Compression (TC) 
 Tension-compression concentrically braced systems shall not exceed 60 m in 

height, except where the specified short-period spectral acceleration is less 
than 0.35 (CSA 27.6.2.1). The factored seismic force is increased by 2% per 
meter of height above 48 m when the building height exceeds 48 m. This 
clause has not been implemented in the program yet. The user is required to 
check this clause independently. 

4.4.5.2 Chevron(V) 
 Chevron concentrically braced systems shall not exceed 60 m in height (CSA 

27.6.2.2). The factored seismic force is increased by 2% per meter of height 
above 48 m when the building height exceeds 48 m (CSA 27.6.2.1). This 
clause has not been implemented in the program yet. The user is required to 
check this clause independently. 

 The beams to which chevron bracing is attached shall be continuous and 
shall resist bending moments due to gravity loads (assuming no vertical sup-
port is provided by the bracing members), in conjunction with bending mo-
ments and axial forces induced by forces of AgRyFy and 0.2 AgRyFy in the ten-
sion and compression bracing members, respectively (CSA 27.6.1, 27.5.2.4).  

When braces are connected to the beam from above, the brace compression 
force shall be taken as 1.2 times the probable compressive resistance of the 
bracing member (CSA 27.6.1, 27.5.2.4).  

In the case of buildings up to four stories, the tension brace force may be tak-
en as 0.6 AgRyFy, provided that the beam is a Class 1 section (CSA 27.6.1, 
27.5.2.4).  

The exception clause in this section is not used by the program. 
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4.4.5.3 Tension-Only (TO) 
 Tension-only concentrically braced systems shall not exceed 40 m in height. 

The factored seismic force is increased by 3% per meter of height above 32 
m when the building height exceeds 32 m (CSA 27.6.2.3(a)). 

 The slenderness ratio, KL/r, of diagonal bracing member shall not exceed 
200 (CSA 27.6.1, 27.5.3.1) with the following exception. In single-story and 
two-story structures, the slenderness ratio of diagonal bracing members that 
are connected and designed as tension only bracing members (CSA 27.5.2.5) 
shall not exceed 300 (CSA 27.6.3.1). 

4.4.6 Eccentrically Braced Frames (EBF) 
For this framing system (Rd = 4.0, Ro = 1.5), the following additional require-
ments are checked or reported (CSA 27.7).  

For this framing system, the program looks for and recognizes the eccentrically 
braced frame configurations shown in Figure 4-1. The following additional re-
quirements are checked or reported for the beams, columns, and braces associ-
ated with these configurations.  

 When e ≤ 1.6 Mp /Vp, the link beams may have Class 2 flanges and Class 2 
web (CSA 27.7.2.3); otherwise, link beams are checked to be Class 1 (CSA 
27.7.2.3). 

    where, 

 e = length of link 

 0.55p w yV t dF=  (CSA 27.7.2.3) 

    If this criterion is not satisfied, the program issues an error message. 
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Figure 4-1. Eccentrically Braced Frame Configurations 

 The shear resistance for link beams is taken as follows (CSA 27.7.3):  

 ( )min , 2r p pV V M e≤ φ φ  (CSA 27.7.3) 

 where, 

 
2

' 1 ,f
p p

y

P
V V

AF
 

= −  
 

 (CSA 27.7.3) 

 ' 1 18 1 f
p p p

y

P
M M M

AF
 

= . − ≤ , 
  

 (CSA 27.7.3) 

 0.55p yV t d F= ,ω  (CSA 27.7.3) 

 fP = Axial force in link (Cf or Tf), (CSA 27.7.3) 

 e    = length of link, (CSA 27.7.3) 

 A   = gross area of link beam. (CSA 27.7.3) 

 If 0 15 ,f yP AF> .  the link beam length, ,e  is checked not to exceed the fol-

lowing:  

– if ≥ .0 3 fw

f

VA
A P
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   

≤ −   
      
1.15 0.5 1.6f pw

f p

P MA
e

V A V
 (CSA 27.7.4) 

– if < .0 3 fw

f

VA
A P

 

  1.6 p

p

M
e

V
 

≤  
  

 (CSA 27.7.4) 

where,  

 ( 2 )w f wA d t t= −  for I-Shaped, Channel and T-Shaped sections 

   (CSA 27.7.4) 

 = 2(d − 2tf)tw for Box and Double Channel section 

 = 2vA
A

 for all other sections. 

If the check is not satisfied, the program reports an error message.  

 The link beam rotation, ,θ of the individual bay relative to the rest of the 
beam is calculated as the story drift ∆ times bay length ( L ) divided by the 
total lengths of link beams ( )e in the bay.  

The link rotation, ,θ  is checked as follows (CSA 27.7.5): 

L
e

∆
θ =  

– 0 08.θ ≤  radian, where link beam clear length, ≤ 1 6 p pe . M V   

– 0 02.θ ≤  radian, where link beam clear length, ≥ 2 6 p pe . M V   

– θ ≤ value interpolated between 0.08 and 0.02 as the link beam clear 
length varies from 1 6 p p. M V  to 2 6 p p. M V .  

The story drift is calculated as 
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 3 s ,∆ = ∆  (CSA 27.7.5) 

 1 = bay length 

 The beam strength outside the link is checked to be at least 1.30 Ry times 
the beam force corresponding to the controlling link beam shear strength 
(CSA 27.7.9.2). The controlling link beam nominal shear strength is taken 
as follows:  

 ( )min 2r p pV V M e′ ′≤ φ φ  (CSA 27.7.9.2) 

The values of ′
pV  and ′

pM  are calculated following the procedure de-
scribed previously (CSA 27.7.3). The correspondence between brace force 
and link beam force is obtained from the associated load cases that has the 
highest link beam force. 

 Each diagonal brace and its end connections shall have a factored re-
sistance to support axial force and moment produced by the strain-
hardened link. The forces developed in the link shall be taken as 1.30Ry 
times the nominal strength of the link. 

 Columns shall be designed to resist the cumulative effect of yielding links, 
together with the gravity loads. The link forces shall be taken as 1.15Ry 
times the nominal strength of the link, except that in the top two stories, the 
force shall be taken as 1.30Ry times the nominal value. Column resistances 
shall satisfy the requirements of Clause 13.8, except that the interaction 
value shall not exceed 0.65 for the top column tier in the braced bay and 
0.85 for all other columns in the braced bay. Column sections shall be 
Class 1 or Class 2 (CSA 27.7.12.2).  

 All braces are checked to be at least Class 1 or Class 2 (CSA 27.7.10.1). If 
this criterion is not satisfied, the program issues an error message.  

 All column members are checked to be at least Class 1 or 2. If these crite-
ria are not satisfied, the program issues an error message (CSA 27.7.12.1). 

Note: Axial forces in the beams are included in checking the beams. The user 
is reminded that using a rigid diaphragm model will result in zero axial forces 
in the beams. The user must disconnect some of the column lines from the dia-
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phragm to allow beams to carry axial loads. It is recommended that only one 
column line per eccentrically braced frame be connected to the rigid diaphragm 
or that a flexible diaphragm model be used.  

4.4.7 Special Plate Shear Walls (SPSW) 
No special consideration for this type of framing system is given by the pro-
gram. The user is required to check the seismic design requirements for SPSW 
independently (CSA27.9). 

4.4.8 Conventional Moment Frame (MF) 
For this framing system, the following additional requirements are checked or 
reported (CSA 27.11).  

 This framing system is checked to be designed using a force reduction fac-
tor Rd = 1.5, Ro = 1.3.  

 The primary framing members of the seismic load resisting system are de-
signed to resist gravity loads combined with seismic loads multiplied by Rd 
when the specified short-period spectral acceleration ratio is greater than 
0.45. This clause has not been implemented in the program yet. The user is 
required to check this clause independently. 

4.4.9 Conventional Braced Frame (BF) 
For this framing system, the following additional requirements are checked or 
reported (CSA 27.11).  

 This framing system is checked to be designed using a force reduction fac-
tor Rd = 1.5, Ro = 1.3.  

 The primary framing members of the seismic load resisting system are de-
signed to resist gravity loads combined with seismic loads multiplied by Rd 
when the specified short-period spectral acceleration ratio is greater than 
0.45. This clause has not been implemented in the program yet. The user is 
required to check this clause independently. 
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4.4.10 Cantilever Column 
For this framing system, the following additional requirements are checked or 
reported (CSA 27.11.2).  

 This framing system is checked to be designed using a force reduction fac-
tor Rd = 1.0, Ro = 1.0. Class 1 sections are to be designed using a force re-
duction factor Rd = 1.5, Ro = 1.3(CSA 27.11.2(a)). This clause has not been 
implemented in the program yet. The user is required to check this clause 
independently. 

 U2 shall be less than or equal to 1.25. If this criterion is not satisfied, the 
program issues an error message. 

4.5 Joint Design 
When using the SEISMIC design code, the structural joints are checked and 
designed for the following.  

 Check the requirement of continuity plate and determination of its area  

 Check the requirement of doubler plate and determination of its thickness  

 Check the ratio of beam flexural strength to column flexural strength  

 Report the beam connection shear  

 Report the brace connection force  

4.5.1 Design of Continuity Plates 
In a plan view of a beam-column connection, a steel beam can frame into a 
column in the following ways.  

 The steel beam frames in a direction parallel to the column major direction, 
i.e., the beam frames into the column flange.  

 The steel beam frames in a direction parallel to the column minor direc-
tion, i.e., the beam frames into the column web.  
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 The steel beam frames in a direction that is at an angle to both of the prin-
cipal axes of the column, i.e., the beam frames partially into the column 
web and partially into the column flange.  

To achieve a proper beam-column moment connection strength, continuity 
plates such as shown in Figure 2.3 of Chapter 2 are usually placed on the col-
umn, in line with the top and bottom flanges of the beam, to transfer the com-
pression and tension flange forces of the beam into the column. For connection 
conditions described by the first bullet, where the beam frames into the flange 
of the column, such continuity plates are not always needed. The requirement 
depends on the magnitude of the beam-flange force and the properties of the 
column. This is the condition that the program investigates. Columns of  
I-sections only are investigated. The program evaluates the continuity plate re-
quirements for each of the beams that frame into the column flange (i.e., paral-
lel to the column major direction) and reports the maximum continuity plate 
area that is needed for each beam flange. The continuity plate requirements are 
evaluated for moment frames (LD MRF, MD MRF and D MRF) only. No 
check is made for braced frames (LD CBF, MD CBF, EBF). 

The program first evaluates the need for continuity plates. When the required 
strength bfP exceeds the bearing resistance of the web rB  as appropriate, a con-
tinuity plate will be required. The program checks the following limit states.  

 The factored bearing resistance of the column web against local yielding at 
the toe of the fillet is given as follows (CSA 14.3.2):  

 ( 10 )r bi fb fc y wB t t F t= φ +  End column (CSA 14.3.2(a)(i)) 

 ( 4 )r be fb fc y wB t t F t= φ +  Interior column (CSA 14.3.2(b)(i)) 

 where 

 0.80biφ =  

 0.75beφ =  

 The available strength of the column web against crippling is given as fol-
lows:  
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 21.45r bi wc yB t F E= φ  End column (CSA 14.3.2(a)(ii)) 

 20.60r be wc yB t F E= φ  Interior column (CSA 14.3.2(b)(ii)) 

 where 

 0.80biφ =  

 0.75beφ =  

If any of the preceding conditions are not met, the program calculates the re-
quired continuity plate area as follows (CSA 14.4.2).  

 
( )bf r

cp
cr

P B
A

F
−

= ,
φ

 End column 

 
( )bf r

cp
cr

P B
A

F
−

= ,
φ

 Interior column 

In the preceding expressions, Fcr is the factored axial compressive stress of the 
equivalent column related to the beam-column joint. Fcr is taken as follows: 

( )−
= φ + λ

1
21 ,n n

cr yF F  (CSA 13.3.1, 14.4.2) 

where, 

φ = 0.90, (CSA 13.1) 

n = 1.0 (assumed conservatively), (CSA 13.3.1) 

λ = ,yfKl
r Eπ

 (CSA 13.3.1) 

K = 0.75, (CSA 14.4.2) 

l = dc − 2tfc, and (CSA 14.4.2) 
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r = min{r33, r22} of the equivalent column. 

The member properties of the equivalent column are taken as follows: 

 The cross-section is comprised of two stiffeners and a strip of the web having 
a width of 25twc at the interior stiffener and 12twc at the ends of the column 
(CSA 14.4.2). 

 The effective length is taken as 0.75h, i.e., K = 0.75 and l = h = dc − 2tfc 
(CSA 14.4.2). 

 Kl
r

 is calculated based on the equivalent cross-section and equivalent length 

stated here. 

In addition to satisfying the preceding limit states, it is made sure that the 
equivalent section, consisting of the stiffeners and part of the web plate, is able 
to resist the compressive concentrated force (CSA 14.4.2). This is similar to a 
column capacity check. For this condition, the program calculates the required 
continuity plate area as follows: 

225 ,bf
cp wc

cr

P
A t

F
= −

φ
 if not at top story (CSA 14.4.2) 

212 ,bf
cp wc

cr

P
A t

F
= −

φ
 if at top story (CSA 14.4.2) 

An iterative process is involved as Acp, r, and Fcr are interdependent. If Acp is 
needed, iteration starts with the minimum thickness and minimum width of the 
continuity plate. A maximum of three iterations is performed. 

If ≤ 0,cpA  no continuity plates are required. If continuity plates are required, 

they must satisfy a minimum area specification defined as follows:  

 The minimum thickness of the stiffeners is taken as follows:  

 min 0 5cp fbt t= .   (borrowed from AISC J10.8) 
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If the maximum thickness is more than the upper limit, the program reports 
an error. Here it is assumed that the continuity plate can extend for the full 
width of the column flange. 

 The minimum width of the continuity plate on each side plus 1/2 the thick-
ness of the column web shall not be less than 1/3 of the beam flange width, 
or  

 min 2
3 2
fp wc

cp

b tb
 

= − 
 

 (borrowed from AISC J10.8) 

 So that the minimum area is given by  

 min min min .cp cp cpA t b=   

Therefore, the continuity plate area provided by the program is zero or the 
greater of cpA  and min .cpA   

In the preceding equations,  

cpA  = Required continuity plate area  

yF  = Yield stress of the column and continuity plate material  

bd  = Beam depth  

cd  = Column depth  

h  = Clear distance between flanges of column less fillets for rolled 
shapes  

ck  = Distance between outer face of the column flange and web toe of its 
fillet  

uM  = Factored beam moment  

bfP  = Beam flange force, assumed as ( )u b tbM d t−   

rB  = Factored bearing resistance of web  
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fbt  = Beam flange thickness  

fct  = Column flange thickness  

wct  = Column web thickness  

φ  = Resistance factor 

The special seismic requirements additionally checked by the program are de-
pendent on the type of framing used. Continuity plate requirements for seismic 
design are evaluated for moment frames (LD MRF, MD MRF and D MRF) on-
ly. No checks are performed for braced frames (LD CBF, MD CBF, EBF).  

Note that the code insists on designing the continuity plate to match with tested 
connection. 

For Seismic cases, 

 1.1of y tb fb ybP R b t f=   (CSA 27.2.5.2) D MRF 

 1.1fb y fb fb yP R b t f=   (CSA 27.3, 27.2.5.2) MD MRF 

 1.1bf y fb fb yP R b t f=   (CSA 27.4.4.5, 27.4.4.1) LD MRF 

4.5.2 Design of Doubler Plates 
One aspect of the design of a steel framing system is an evaluation of the shear 
forces that exist in the region of the beam-column intersection known as the 
panel zone.  

Shear stresses seldom control the design of a beam or column member. How-
ever, in a Moment-Resisting frame, the shear stress in the beam-column joint 
can be critical, especially in framing systems when the column is subjected to 
major direction bending and the joint shear forces are resisted by the web of 
the column. In minor direction bending, the joint shear is carried by the column 
flanges, in which case the shear stresses are seldom critical, and this condition 
is therefore not investigated by the program.  
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Shear stresses in the panel zone, due to major direction bending in the column, 
may require additional plates to be welded onto the column web, depending on 
the loading and the geometry of the steel beams that frame into the column, ei-
ther along the column major direction or at an angle so that the beams have 
components along the column major direction. See Figure 2-3 of Chapter 2. 
The program investigates such situations and reports the thickness of any re-
quired doubler plates. Only columns with I-Shapes are investigated for doubler 
plate requirements. Also doubler plate requirements are evaluated for moment 
frames (LD MRF, MD MRF and D MRF) only. No check is made for braced 
frames (LD CBF, MD CBF, EBF). 

The program calculates the required thickness of doubler plates using the fol-
lowing algorithms. The shear force in the panel zone, is given by:  

 
1

cos .
bn

bn n
p c

n n fn

MV V
d t=

θ
= −

−∑  

The available strength of the web panel zone for the limit state of shear yield-
ing resistance is determined as Vr as appropriate. Assuming that the effect of 
panel zone deformation on frame stability has not been considered in analysis, 
the shear resistance, Vr is determined as follows: 

(a) When detailed in accordance to the following conditions: 

i. When the doubler plate is Plug welded. 

ii. When the specified short-period spectral acceleration ratio (IEFaSa(0.2)) 
is equal to or greater than 0.55, and when the joint panel zone is de-
signed such that the sum of panel zone depth and the width divided by 
panel zone thickness does not exceed 90 (CSA 27.2.4.3(a)). 

iii. The joint panel zone is designed to satisfy the width-to-thickness limit 
of CSA Clause 13.4.1.1(a), i.e., 439wc wc v yd t k F=  (CSA27.2.4.3(b)).  

 
23

0.55 1 0.66fc fc
r v wc p yc v wc p y

c wb wc

b t
V d t F d t F

d d d
 

= φ + ≤ φ , 
  

  

  (CSA 27.2.4.2.1) 
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By using Vp = Vr, the required column panel zone thickness tp is found as 
follows.  

 
2

.
0.663

0.55 1

p p
p

v wc p yfc fc
v wc p y

c wb wc

V V
t

d t Fb t
d t F

d d d

= ≤
φ 

φ + 
  

 

(b) When detailed in accordance to the following conditions: 

i. Joint panel zone is designed to satisfy the width-to-thickness limit of 
CSA Clause 13.4.1.1(a) i.e., 439wc wc v yd t k F=  (CSA27.2.4.3(b)). 

 0.55 .r v wc p yV d t F= φ  (CSA 27.2.4.2.2) 

By using Vp = Vr, the required column panel zone thickness tp is found 
as follows.  

 
0.55

p
p

v wc p y

V
t

d t F
=

φ
   

The extra thickness or the required thickness of the doubler plate is 
given as follows: 

 = −dp p wt t t ,  

where 

yF  = Column and doubler plate yield stress  

pt  = Required column panel zone thickness  

fnt  = Flange thickness of the thn-  beam  

dpt  = Required doubler plate thickness  

fct  = Column flange thickness  

wt  = Column web thickness  
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pV  = Required panel zone shear capacity  

cV  = Column shear in the column above  

bn  = Number of beams connecting to a column  

nd  = Overall depth of the thn-  beam connecting to a column  

nθ  = Angle between the thn-  beam and the column major di-
rection  

cd  = Overall depth of the column  

bnM  = Factored beam moment from corresponding loading 
combination  

rV  = Shear resistance of a panel  

rP  = Required axial resistance  

The largest calculated value of tdp, calculated for any of the load com-
binations based on the factored beam moments and factored column 
axial loads, is reported.  

Doubler plate requirements for seismic design are evaluated for D 
MRF (CSA 27.2.4.2), MD MRF (CSA 27.3, 27.2.4.2), LD MRF (CSA 
27.4.3, 27.2.4.2) only. No further check/design is performed for other 
types of frames.  

The doubler plate and the column web should satisfy the slenderness 
criteria (CSA 27.2.4.3(a)). t is taken as twc + tdp when the doubler plate 
is plug welded to prevent local buckling. In such cases, tdp is increased 
if necessary to meet this criterion. If the doubler plate is not plug weld-
ed to the web, t is taken as twc and also as tdp for checking both the 
plates. If the twc cannot satisfy the criteria, then a failure condition is 
declared. If  tdp does not satisfy this criterion, then its value is increased 
to meet the criteria. If the check is not satisfied, it is noted in the out-
put.  
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4.5.3 Weak Beam/Strong Column Measure 
Only for Ductile Moment Resisting Frames (D MRF) and Moderately Ductile 
Moment Resisting Frames (MD MRF) with seismic design, the code requires 
that the sum of column flexure strengths at a joint be more than the sum of 
beam flexure strengths (CSA 27.2.3.2, 27.3). The column flexure strength 
should reflect the presence of the axial force present in the column. The beam 
flexural strength should reflect the potential increase in capacity for strain 
hardening. To facilitate the review of the strong column/weak beam criterion, 
the program will report a beam-column plastic moment capacity ratio for every 
joint in the structure.  

When the specified short-period spectral acceleration ratio is greater than 0.55 
or the building is greater than 60 m in height, columns shall satisfy the re-
quirements of Class 27.2.3.2; however, when applying Clause 27.2.3.2, the 
term 1.1RyMpb may be replaced by Mpb. In addition, the beams shall be de-
signed so that for each story, the story shear resistance is not less than that of 
the story above. 

The preceding equation can be written as follows: 

When IeFaSa(0.2) > 0.55 or when the building height is greater than 60 m, col-
umns are designed for: 

 
2
c

rc pb h
dM M V x

  ′ ≥ + +  
  

∑ ∑   (CSA 27.2.3.2) 

where 

rcM ′∑ = sum of the column factored flexural resistance at the intersec-

tion of the beam and column centerlines. 

1.18 1 f
rc pc pc

y

C
M M M

C
 

′ = φ − ≤ φ  φ 
∑  (CSA 27.2.3.2) 

pcM  = nominal plastic moment resistance of the column 

fC   = results from summation of Vh acting at this level and above 

pbM  = nominal plastic moment resistance of the beam 
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Vh = shear acting at that plastic hinge location where 1.1RyMpb is 
reached at the beam hinge locations 

x       = distance from the center of a beam plastic hinge to the column 
face, which shall correspond to that of the assembly used to 
demonstrate performance in accordance with Clause 27.2.5.1. 

For the major direction of any column (top end), the beam-to-column-strength 
ratio is obtained as  

 1
maj

cos
.

bn

pbn n
n

pcax pcbx

M
R

M M

∗

=
∗ ∗

θ
=

+

∑
 

For the minor direction of any column, the beam-to-column-strength ratio is 
obtained as  

 1
min

sin
bn

pbn n
n

pcay pcby

M
R

M M

∗

=
∗ ∗

θ
= ,

+

∑
 

where, 

majR  = Plastic moment capacity ratios, in the major directions of the 

column  

minR  = Plastic moment capacity ratios, in the minor directions of the 
column 

∗
pbnM  = Plastic moment capacity of -thn  beam connecting to column  

nθ  = Angle between the -thn  beam and the column major direc-

tion  

∗
,pcax yM  = Major and minor plastic moment capacities, reduced for axial 

force effects, of the column above the story level  

∗
,pcbx yM  = Major and minor plastic moment capacities, reduced for axial 

force effects, of the column below the story level  
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bn  = Number of beams connecting to the column  

The plastic moment capacities of the columns are reduced for axial force ef-
fects and are taken as  

 1.18 1 f
pc rc pc pc

y

C
M M M M

C
∗

 
′= = φ − ≤ φ  φ 

 (CSA 27.2.3.2, 27.3) 

The plastic moment capacities of the beams are amplified for potential increase 
in capacity for strain hardening as follows: 

For D MRF and MD MRI 

 1.1
2

∗  ′= = + + 
 

c
pb rb y pb h

dM M R M V x  (CSA 27.2.3.2, 27.3) 

For LD MRF 

 ( )∗ = + +pb b h cM M V x a  (CSA 27.4.2.2) 

rcM ′  = Factored plastic moment resistance of the column 

fC   = Results from summation of Vh acting at this level and above 

rbM ′  = Amplified plastic moment resistance of the beam 
x       = Distance from the center of a beam plastic hinge to the column face 
Vh   =  Shear acting at plastic hinge location when 1.1RyMpb is reached at the 

hinge location.  

For the preceding calculations, the section of the column above is taken to be 
the same as the section of the column below, assuming that the column splice 
will be located some distance above the story level.  

4.5.4 Evaluation of Beam Connection Shears 
For each steel beam in the structure, the program will report the maximum ma-
jor shears at each end of the beam for the design of the beam shear connec-
tions. The beam connection shears reported are the maxima of the factored 
shears obtained from the loading combinations.  
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For special seismic design, the beam connection shears are not taken less than 
the following special values for different types of framing. The special seismic 
requirements additionally checked by the program are dependent on the type of 
framing used.  

 For D MRF, MD MRF and LD MRF, the beam connection shear is taken as 
the maximum of those from regular load combinations and those required for 
the development of full plastic moment capacity of the beam, i.e., 1.1RyZFy 
(CSA 27.2.5.2, 27.3, 27.4.4.2(a)). The connection shear for the development 
of the full plastic moment capacity of beam is as follows:  

 
1.3
d o

f DL LL
R RV EL V V= + +  (CSA 27.2.5.2, 27.3, 27.4.4.2(b)) 

where, 

fV  = Shear force corresponding to END I or END J of the beam 

EL = Maximum anticipated seismic load 

Lh = Clear length of the beam 

DLV  = Absolute maximum of the calculated beam shears at the cor-
responding beam ends from the factored dead load only 

LLV  = Absolute maximum of the calculated beam shears at the cor-
responding beam ends from the factored live load only 

If the beam-to-column connection is modeled with a pin in the program by 
releasing the beam end, it automatically affects the beam connection shear. 

4.5.5 Evaluation of Brace Connection Forces 
For each steel brace in the structure, the program reports the maximum axial 
force at each end of the brace for the design of the brace-to-beam connections. 
The brace connection forces reported are the maxima of the factored brace axi-
al forces obtained from the loading combinations.  

For special seismic design, the brace connection forces are not taken less than 
the following special values for different types of framing. The special seismic 
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requirements additionally checked by the program are dependent on the type of 
framing used.  

Brace axial forces for seismic designs are evaluated for braced frames (LD 
CBF, MD CBF, EBF) only. No special checks are performed for moment 
frames (DMRF, MD MRF, LD MRF).  

 For MD CBF and LD CBF, the bracing connection force is taken as the min-
imum of the two values (CSA 27.5.4.2(a)): 

a. The expected yield strength in tension of the bracing member, deter-
mined as TyFyAg (CSA 27.5.4.2(a)) and 1.2 times the probable compres-
sive resistance of the bracing members, determined as rC φ . 

 For EBF, the required strength of the diagonal brace connection at both ends 
of the brace is taken as the maximum of the following two values: (a) the 
maximum connection force from the design load combinations, and (b) the 
maximum brace connection force based on 1.30Ry times the nominal strength 
of the link (CSA 27.7.9.2). 

The maximum connection force from the load combinations is determined 
for all of the regular load combinations.  
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Chapter 5 
Design Output 

5.1 Overview 
The program has the capacity to create design output in four major ways – 
graphical display, file output, tabular display, and member specific detailed de-
sign information.  

The graphical display includes input and output design information for members 
visible in the active window; the display can be sent directly to a printer or saved 
to a file. The file output includes both summary and detail design data that can be 
saved in RTF, HTML and plain text formats. The tabular display output includes 
both summary and detail design data that can be displayed or saved in many 
formats, including Excel, Access, RTF, HTML and plain text. The member 
specific detailed design information shows the details of the calculation.  

The following sections describe some of the typical graphical display, file out-
put, tabular display output, and member specific detailed design information. 
Some of the design information is very specific to the chosen steel design code. 
This manual addresses "CSA S16-09" design code related output information 
only.  
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5.2 Display Design Information on the Model 
The graphical display of design output includes input and output design infor-
mation for all steel frame members that are visible in the active window. The 
graphical output can be produced in color or in gray-scaled screen display. The 
active screen display can be sent directly to the printer or saved to a file in sev-
eral formats.  

Input and output design information for the CSA S16-09code includes the fol-
lowing. 

Table 5-1 Graphical Display of Design Information 
Design Input Information Design Output Information 

 Design sections 
 Design type 
 Live load reduction factors 
 Unbraced length ratios, L-factors,  

for major and minor direction of bending,  
and for lateral-torsional buckling 

 Effective length factor for sway condition, 
K-factors, for major and minor directions  
of bending 

 Effective length factors, Kz, for  
lateral-torsional buckling 

 ω1 factors for major and minor  
directions of bending 

 ω2 factors for major and minor  
directions of bending 

 U1 factors for major and minor  
directions of bending 

 U2 factors for major and minor  
directions of bending 

 Rd factors 
 Ro factors 
 Yield stress, Fy  
 Nominal axial capacities 
 Nominal bending capacities 
 Nominal shear capacities 

 P-M stress ratio values with members 
color-coded based on the ratio 

 P-M colors and shear stress ratio val-
ues 

 P-M ratio colors and no values 
 Identify the P-M failure 
 Identify the shear failure 

 Identify all failures 

Note that only one of the listed items can be displayed on the model at a time.  
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Use the Design menu > Steel Frame Design > Display Design Info command 
in SAP2000/ETABS and Advanced > Frame Design > Steel > Display Design 
Info  command in CSiBridge to plot design input and output values directly on 
the model. The Display Steel Design Results form shown in Figures 5-1 and 5-2 
will display. Choose the Design Output or Design Input option. One item can be 
selected from the drop-down list. For example, the P-M interaction ratios can be 
displayed by choosing the Design Output option and selecting P-M Ratio Colors 
& Values from the drop-down list. Click the OK button to display the longitu-
dinal reinforcing in the active window. A typical graphical display of longitu-
dinal reinforcing is shown in Figure 5-3.  

 
Figure 5-1  Choice of design input data for display on the model  

 in the active window 

 
Figure 5-2  Choice of design output data for display on the model  

 in the active window 
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Figure 5-3  A typical graphical display 

The graphics can be displayed in 3D or 2D mode. The standard view transfor-
mations are available for all steel design information displays. Several buttons 
on the toolbar can be used to switch between 3D and 2D views. Alternatively, 
click the View menu  > Set 3D View or Set 2D View commands in 
SAP2000/ETABS and the Home > View > Set 3D View or Set 2D View 
commands in CSiBridge.  

The onscreen graphical display can be sent to a printer using any of the fol-
lowing commands. Use the File menu > Print Graphics command in 
SAP2000/ETABS and the Orb > Print > Print Graphics command in 
CSiBridge to print the active window. To capture the graphical display in a file 
for printing through another application, use the File menu > Capture En-
hanced Metafile command in SAP2000/ETABS and the Orb > Pictures > 
Metafile command in CSiBridge to create an .emf file, or use the File menu > 
Capture Picture command in SAP2000/ETABS and the Orb > Pictures > 
Bitmap* command in CSiBridge  to create a bitmap (.bmp) file. Create a screen 
capture of the active window using the Alt+ Print Screen keyboard keys or 
create a screen capture of the entire window using the Ctrl + Print Screen 
keyboard keys. Then use the Ctrl+V keyboard keys to paste the saved image 
into Paint or other graphical program.  
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By default the graphical displays are in color. It may be advantageous to view or 
present the display in gray-scale graphics or using a white background. Use the 
Options menu > Color command to set these options.  

5.3 Display Design Information in Tables 
In addition to model definition and analysis results, the design information for 
all steel frame members or for only selected members can be displayed in tabular 
spreadsheet format. Currently, the program generates design summary data, 
PMM design details and shear design details. The tabular spreadsheet output can 
be displayed by selecting the Display menu > Show Tables command in 
SAP2000/ETABS and the Home > Display > Show Tables command in 
CSiBridge to access the Choose Tables for Display form, an example of which 
is shown in Figure 5-4. That form can be used to choose which tables or sets of 
tables are to be displayed.  

The names of the tables are displayed in a tree structure, which can be collapsed 
or expanded by clicking on an item in the tree. Click on the small check boxes 
preceding the items to select those tables for display. If a branch of the tree is 
selected, all of the tables under that branch are selected. The selected set of ta-
bles can be saved as a Named Set using the Save Named Set button. This named 
set can be used in the future for quick selection. If one or more frame members 
are selected on the structural model before accessing the Choose Tables for 
Display form, the Selection Only check box will be checked when the form 
displays, and the program will display information for the selected members 
only; uncheck the check box to display information for all applicable "unse-
lected" members in the model. If the Show Unformatted check box is checked, 
the numbers will be displayed unformatted instead of being displayed using a 
limited number of decimal digits. The unformatted option provides higher pre-
cision output that can then be copied into other programs.  

Use the other buttons in the form to tailor the data display. For example, click the 
Select Load Cases button to specify which load cases are to be included in the 
display of model definition data; click the Select Analysis Case and Modi-
fy/Show Options to specify which analysis cases are to be included and how 
analysis results are displayed.  
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Figure 5-4  Choice of design data tables for tabular display 

After selecting all of the tables for steel frame design and the display options, 
click the OK button to display a form showing one of the selected design tables, 
with a drop-down list in the upper right-hand corner of the form that can be used 
to select other tables for display. A typical design table is shown in Figure 5-5.  

Use the scroll bars on the bottom and right side of the tables to scroll right and 
left or up and down if portions of the data table can not be displayed in the form's 
display area. The columns can be resized by clicking the left mouse button on 
the separator of the headers, holding down the left mouse button and then 
dragging the mouse to the left or right. Reset the column widths to their default 
values by selecting the View menu > Reset Default Column Widths command 
on the form. The table can be split into two or more tables by clicking on the 
small black rectangular area near the bottom-left corner of the table, holding 
down the left mouse button, and then dragging the mouse button to the left or 
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right. Repeat this process to add more splits. Use the split and horizontal scroll 
bar to put two columns side by side for easier comparison. The splits can be 
removed by selecting the View menu > Remove Splits command on the form. 
Alternatively, remove the split by clicking, holding and dragging the left mouse 
button to merge the split key to its original location.  

 
Figure 5-5  A typical tabular display of design data 

Select multiple consecutive columns by putting the cursor on the header, holding 
down the mouse button, and then dragging the mouse button left or right. Al-
ternatively, depress the Shift key and click the left mouse button to select a range 
of columns.  

The current table (i.e., the table in the active window) can be copied to the 
Window clipboard and them pasted into popular programs such as Excel, Ac-
cess, .rtf., .html, and plain text formats. Many other features of the design tables 
are left for the user to discover by using the program. 

5.4 Display Detailed Member Specific Information 
The program has the capability to display the design details for a specific 
member. The information includes member identification, shape name, section 
properties, design combination name, design combination forces, and other de-
sign input data to check the design results. The information also includes stress 
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ratios for P-M-M and other interactions, demand/capacity ratios from shear, 
nominal strengths, design factors such as ω1, ω2, U1, U2, and so forth. The design 
details are displayed in a summary form and also are displayed for a specific 
load combination and for a specific station of a frame member. 

When the design results are displayed on the model in the active window, the 
detailed design information can be accessed by right clicking on the desired 
frame member to display the Steel Stress Check Information form. Alterna-
tively, click the Design menu > Steel Frame Design > Interactive Steel 
Frame Design command in SAP2000/ETABS and the Advanced > Frame 
Design > Steel >  Interactive Steel Frame Design command in CSiBridge and 
then right click on the frame member. An example of that form is shown in 
Figure 5-6.  

 
Figure 5-6  A typical member specific steel stress check information summary 

Note: It should be noted that two design processes are available in 
CSiBridge:  superstructure design (on the Design/Rating tab, including 
the Optimize command that can be used to interactively design a steel 
I-beam superstructure) and design of the individual elements comprising 
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the structure (the Advanced > Frame Design commands). This manual 
addresses the second design process. 

The Steel Stress Check Information form identifies the frame members and the 
analysis and design section, and includes a display area of mostly de-
mand/capacity ratio data and buttons that access forms that provide further de-
tails about the selected frame member. The display area reports the load 
combinations, the stress check stations, the P-M-M interaction ratio along with 
its axial and flexural components, and the shear stress ratios. The load combi-
nation is reported by its name, while the station is reported by its location, which 
is measured from the I-end of the column. The number of reported line items in 
the text box is equal to the number of design combinations multiplied by the 
number of stations. Only one line item is highlighted in blue when the form first 
displays. That item highlights the largest demand/capacity ratio from P-M-M, 
major and minor shear or any other considered interaction ratio, unless a line 
item(s) has design overstress or an error. In that case, the item with the overstress 
or error will be selected and highlighted. If many line items are overstressed or 
have an error, the last among all such line items will be selected and highlighted. 

The stress check information is always reported for the design section. If the 
member is assigned an individual section, the analysis and design section are 
always the same. If the member is assigned an Auto Select Section (a list of 
sections), the analysis and design section can be different, unless the design has 
converged. 

The Overwrites and Details buttons near the bottom of the Steel Stress Check 
Information form can be used to access the Steel Frame Design Overwrites form, 
and the Steel Stress Check Data form, which displays detailed information about 
the selected frame element. While the latter form displays information in a 
non-editable format, the Overwrites form display the overwrite data in editable 
format. This allows the user to enter an interactive mode of design.  

 Overwrites button. Click this button to access the Steel Frame Design 
Overwrites form. Use that form to make revisions to the steel frame design 
overwrites and then immediately review the new design results as a summary 
using the Steel Stress Check Information form, or in detail by clicking the 
Details button to access the Steel Stress Check Data form. Clicking the OK 
button on the Steel Frame Design Overwrites form temporarily saves any 
changes. To make the changes permanent, click the OK button on the Steel 
Stress Check Information form. To disregard the changes, click the Cancel 
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button on the Steel Stress Check Information form. An example of an Over-
writes form is shown in Figure 5-7. 

 
Figure 5-7  A typical member specific Steel Frame Design Overwrites form 

 Details button. Click this button to access the Steel Stress Check Data form. 
Use the form to review all of the design details for the highlighted item. An 
example of a Steel Stress Check Data form is shown in Figure 5-8. The in-
formation includes the member ID, load combo and station identifications, 
steel design sections, section properties, design combination forces, stress ra-
tios for P-M-M and other interactions, stress ratios for shear, nominal 
strengths, and design factors such as, ω1, ω2, U1, U2, and so forth. Values that 
are not applicable are reported as N/A. Similarly, N/C and N/N indicate an 
item is “Not Calculated” and “Not Needed.” 
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Before clicking the Details button on the form shown in Figure 5-6, highlight 
an item for the desired design station and design load combination in the Steel 
Stress Check Information display area by clicking on the line. The data sub-
sequently displayed will relate to the highlighted item. By default, the most 
critical line item is selected when the form first displays, as described previ-
ously. 

To increase or decrease the width of the Steel Stress Check Information form 
(Figure 5-8), put the cursor near the right edge of the form, click the left mouse 
button, and drag the mouse cursor towards the left or right. Similarly, the 
height of the form can be increased or decreased.  

 
Figure 5-8 A typical Steel Stress Check Information form 

The text in the form can be dragged in any direction by positioning the cursor 
in the middle of the form, and then clicking the left mouse button and dragging 
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the text in the desired direction. Similarly, the graphical display of the column 
section can also be dragged in any direction.  

Use the Units drop-down list in the upper right-hand corner of the form to 
change the units used to display the data. Data displayed on the form can be 
sent directly to the printer by selecting the File menu > Print command on the 
form. The program allows limited page setup options using the Print Setup 
command on the File menu on the form.  

5.5 Save or Print Design Information as Tables 
In addition to model definition and analysis results, the design information for 
all steel frame members or for selected frames only can be saved in tabular 
format. Currently for CSA S16-09code, the program saves design summary 
data, PMM design details, and shear design details.  

Save the file output by selecting the File menu > Print Tables command in 
SAP2000/ETABS and the Orb > Print > Print Tables command in CSiBridge 
and selecting the type of information (e.g., Input, Analysis Output, Summary 
Report and so on); the Print Design Tables form will then display. If one or more 
structural members were selected before the Print Design form is accessed, the 
Selection Only check box will be checked and the program will save the data for 
the selected members only; uncheck the check box to save the data for all ap-
propriate  “unselected” members. After the design output is saved in a text file, 
the file can be opened using any text file editor/viewer. However, SAP2000 and 
ETABS  provide the File menu > Display Input/Output Text Files command 
that can be used to display the text file in Window’s Wordpad. 

Using the preceding process without checking the Print to File check box will 
send the specified information directly to the printer. 

5.6 Error Messages and Warnings 
Error messages and warnings may be displayed in the steel frame design output. 
Those messages and warnings are assumed to be self explanatory. 
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 Appendix A 

Supported Design Codes  
The program supports a wide range of steel frame design codes, including the 
following: 

 AISC-ASC 01 

 AISC-ASD 89 

 CAN/CSA S16-01 

 CAN/CSA S16-09 

 AISC-LRFD 99 

 AISC-LRFD 93 

 API-RP2A-LRFD 97 

 API-RP2A-WSD 2000 

 ASCE 10-97 

 BS5950 90 
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 BS5950 2000 

 CISC 95 

 EuroCode 3-1993 

 Indian IS:800-1998 

 Italian UNI 10011 

 UBC97-ASD 

 UBC97-LRFD 

Among all of the listed design codes, ASCE 10-97, API-WSD 2000, and 
API-LRFD 97 codes are available only in SAP2000. ETABS does not support 
those codes. The "Chinese 2002" code is available only in the specialized Chi-
nese version of SAP2000 and ETABS. The specialized Indian version of the 
programs supports only the Indian IS 800-1998 code. 

The list is growing and becomes outdated very often. 

Appendix A - 2  



Bibliography 

CISC, 2006, Handbook of Steel Construction, 9th Edition, Second Revised 
Printing, Canadian Institute of Steel Construction, 201 Consumers Road, 
Suite 300, Willowdale, Ontario M2J 4G8, Canada. 

CSA, 2001. CAN/CSA-S16-01 – Limit States Design of Steel Structures; Ca-
nadian Standards Association, 5060 Spectrum Way, Suite 100, Mississauga, 
Ontario, Canada L4W5N6. 

CSA, 2005. S16S1-05 – Supplement No. 1 to CAN/CSA – S16-01, Limit States 
Design of Steel Structures, Canadian Institute of Steel Construction, 201 
Consumers Road, Suite 300, Willowdale, Ontario M2J 4G8, Canada. 

CSA, 2009. CSA S16-09 – Design of Steel Structures; Canadian Standards 
Association, 5060 Spectrum Way, Suite 100, Mississauga, Ontario, Canada 
L4W5N6. 

CSI, 2012. CSI Lateral Load Manual. Computers and Structures, Inc., 1995 
University Avenue, Berkeley, California, 94704. 

NBCC 2005.  National Building Code of Canada, National Research Council of 
Canada, Ottawa, Ontario. 

 

 Bibliography - 1 


	Title
	Copyright
	Disclaimer
	Contents
	Chapter 01 Introduction
	1.1 Organization
	1.2 Recommended Reading/Practice

	Chapter 02 Modeling, Analysis and Design Prerequisites
	2.1 Check and Design Capability
	2.2 Analysis Sections vs. Design Sections
	2.3 Design and Check Stations
	2.4 Demand/Capacity Ratios
	2.5 Design Load Combinations
	2.6 Second Order P-Delta Effects
	2.7 Notional Load Cases
	2.8 Member Unsupported Lengths
	2.9 Effects of Breaking a Member into Multiple Elements
	2.10 Effective Length Factor (K)
	2.11 Supported Framing Types
	2.12 Continuity Plates
	2.13 Doubler Plates
	2.14 Frame Design Procedure Overwrites
	2.15 Interactive Design
	2.16 Automated Iterative Design

	Chapter 03 Design using CSA S16-09
	3.1 Notations
	3.2 Design Preferences
	3.3 Overwrites
	3.4 Design Loading Combinations
	3.5 Classification of Sections for Local Buckling
	3.6 Calculation of Factored Forces and Moments
	3.7 Calculation of Factored Strengths
	3.7.1 Factored Tensile Strength
	3.7.2 Factored Compressive Strength
	3.7.3 Flexure Strength
	3.7.3.1 I-Shapes, Double Channels and Boxes
	3.7.3.1.1 Major Axis of Bending
	3.7.3.1.2 Minor Axis of Bending

	3.7.3.2 Rectangular Bar
	3.7.3.2.1 Major Axis of Bending
	3.7.3.2.2 Minor Axis of Bending

	3.7.3.3 Pipes and Circular Rods
	3.7.3.4 Channel Section
	3.7.3.4.1 Major Axis of Bending
	3.7.3.4.2 Minor Axis of Bending

	3.7.3.5 T-Shapes and Double Angles
	3.7.3.5.1 Major Axis of Bending
	3.7.3.5.2 Minor Axis of Bending

	3.7.3.6 Angle Sections
	3.7.3.7 General Sections

	3.7.4 Shear Strength
	3.7.4.1 Shear in the Major Direction
	3.7.4.2 Shear in the Minor Direction


	3.8 Design of Members for Combined Forces
	3.8.1 Axial and Bending Stresses
	3.8.1.1 Axial Compressive and Bending — Class 1 and Class 2 I-Shapes
	3.8.1.2 Axial Compression and Bending — Other Sections

	3.8.2 Axial Tension and Bending
	3.8.3 Shear Stresses


	Chapter 04 Special Seismic Provisions
	4.1 Design Preferences
	4.2 Overwrites
	4.3 Supported Framing Types
	4.4 Member Design
	4.4.1 Type (Ductile) Moment-Resisting Frames (D MRF)
	4.4.2 Type (Moderately Ductile) Moment-Resisting Frames (MD MRF)
	4.4.3 Type (Limited-Ductility) Moment-Resisting Frames (LD MRF)
	4.4.4 Type (Moderately Ductile) Concentrically Braced Frames (MD CBF)
	4.4.4.1 Tension-Compression (TC)
	4.4.4.2 Chevron(V)
	4.4.4.3 Tension-Only (TO)

	4.4.5 Type (Limited-Ductility) Concentrically Braced Frames (LD CBF)
	4.4.5.1 Tension-Compression (TC)
	4.4.5.2 Chevron(V)
	4.4.5.3 Tension-Only (TO)

	4.4.6 Eccentrically Braced Frames (EBF)
	4.4.7 Special Plate Shear Walls (SPSW)
	4.4.8 Conventional Moment Frame (MF)
	4.4.9 Conventional Braced Frame (BF)
	4.4.10 Cantilever Column

	4.5 Joint Design
	4.5.1 Design of Continuity Plates
	4.5.2 Design of Doubler Plates
	4.5.3 Weak Beam/Strong Column Measure
	4.5.4 Evaluation of Beam Connection Shears
	4.5.5 Evaluation of Brace Connection Forces


	Chapter 05 Design Output
	5.1 Overview
	5.2 Display Design Information on the Model
	5.3 Display Design Information in Tables
	5.4 Display Detailed Member Specific Information
	5.5 Save or Print Design Information as Tables
	5.6 Error Messages and Warnings

	Appendix A Supported Design Codes
	Bibliography



